Using the guide

Thank you for buying a Brother machine! Reading the documentation will help you make the most of your machine.

Symbols and conventions used in this guide

The following symbols and conventions are used throughout this guide:

⚠️ CAUTION  CAUTION indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injuries.

IMPORTANT  IMPORTANT indicates a potentially hazardous situation which, if not avoided, may result in damage to property or loss of product functionality.

NOTE  Notes tell you how you should respond to a situation that may arise or give tips about other scanning features.

Bold  Bold style identifies keys on the machine or computer screen.

Italic  Italics  Italics emphasises an important point or refers you to a related topic.

Courier New  Text in Courier New font identifies messages on the LCD screen of the machine.

Note

• For PDS-5000F users: This guide uses PDS-6000F screen images, unless otherwise indicated.

• If you use a tablet running Windows®, you can make your selections either by tapping the screen or by clicking with your mouse.
# Table of Contents

1 Scanning Software ................................................................. 1
   Choose your scanning software ................................................. 1

2 General Information ............................................................ 2
   Scanner overview ............................................................... 2
   Control panel ....................................................................... 3
   Control panel overview ....................................................... 3
   LED indications ................................................................... 4
   Machine status messages ..................................................... 4

3 Document Information .......................................................... 5
   Acceptable documents .......................................................... 5
   Unacceptable documents ..................................................... 6
   Documents recommended for use with the Carrier Sheet (for ADF Scan) ............................................... 7

4 Scan Preparation .................................................................. 8
   Set up your machine for Automatic Document Feeder (ADF) use ........................................................... 8
   Set up your machine for Flatbed use ....................................... 9
   Load documents ................................................................... 10
   Loading documents in the ADF .............................................. 10
   Loading documents on the Flatbed’s scanner glass .................. 13
   Loading multiple different-size documents in the ADF .......... 14
   Loading documents using the Carrier Sheet in the ADF ........... 16
   Loading documents wider than Letter/A4 size ......................... 18

5 Scan (Windows®) ................................................................. 20
   Scan using the control panel .................................................. 20
   Assign a scanning application to the Scan button ..................... 20
   Scan a document .................................................................. 24
   Scan using your computer ..................................................... 25
   Scan with DS Capture .......................................................... 25
   Change scan settings using the TWAIN driver ......................... 27
   Functional overview ............................................................. 27
   DS Capture home screen ....................................................... 28
   Scanner Properties dialog box .............................................. 30
   Image tab ............................................................................ 31
   Compression tab .................................................................. 37
   Color Dropout tab ................................................................ 38
   Paper tab ............................................................................. 40
   Multi-Feed Detection tab ....................................................... 45
   Preview tab ......................................................................... 47
   Rotation tab ......................................................................... 50
   Enhancement tab .................................................................. 52
## Table of Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td><strong>Scan (Macintosh)</strong></td>
</tr>
<tr>
<td></td>
<td>Scan using the control panel ........................................................................ 64</td>
</tr>
<tr>
<td></td>
<td>Assign a profile to the Scan button ............................................................... 64</td>
</tr>
<tr>
<td></td>
<td>Scan a document ....................................................................................................... 64</td>
</tr>
<tr>
<td></td>
<td>Scan using your computer ......................................................................................... 65</td>
</tr>
<tr>
<td></td>
<td>Scan with DS Capture ................................................................................................. 65</td>
</tr>
<tr>
<td></td>
<td>Change scan settings using the TWAIN driver ....................................................... 66</td>
</tr>
<tr>
<td></td>
<td>Functional overview ...................................................................................................... 66</td>
</tr>
<tr>
<td></td>
<td>DS Capture screen overview ..................................................................................... 67</td>
</tr>
<tr>
<td></td>
<td>Profile tab .................................................................................................................. 68</td>
</tr>
<tr>
<td></td>
<td>Image tab ..................................................................................................................... 69</td>
</tr>
<tr>
<td></td>
<td>File tab ....................................................................................................................... 75</td>
</tr>
<tr>
<td></td>
<td>Color Dropout tab ....................................................................................................... 77</td>
</tr>
<tr>
<td></td>
<td>Paper tab ...................................................................................................................... 79</td>
</tr>
<tr>
<td></td>
<td>Rotation tab ............................................................................................................... 84</td>
</tr>
<tr>
<td></td>
<td>Enhancement tab .......................................................................................................... 86</td>
</tr>
<tr>
<td></td>
<td>Setting tab .................................................................................................................. 90</td>
</tr>
<tr>
<td></td>
<td>Imprinter tab ............................................................................................................... 91</td>
</tr>
<tr>
<td></td>
<td>Information tab .......................................................................................................... 95</td>
</tr>
<tr>
<td>7</td>
<td><strong>Maintenance</strong></td>
</tr>
<tr>
<td></td>
<td>Clean the outside of your machine ......................................................................... 96</td>
</tr>
<tr>
<td></td>
<td>Clean the Scanner Glass ......................................................................................... 97</td>
</tr>
<tr>
<td></td>
<td>Clean the inside of your machine ............................................................................. 98</td>
</tr>
<tr>
<td></td>
<td>Replace parts .............................................................................................................. 104</td>
</tr>
<tr>
<td></td>
<td>Supply information .................................................................................................... 104</td>
</tr>
<tr>
<td></td>
<td>Check replacement cycle ......................................................................................... 106</td>
</tr>
<tr>
<td></td>
<td>Replace the Rollers ................................................................................................. 106</td>
</tr>
<tr>
<td></td>
<td>Reset the usage counters ....................................................................................... 111</td>
</tr>
<tr>
<td></td>
<td>Packing and shipping the machine ......................................................................... 112</td>
</tr>
<tr>
<td>8</td>
<td><strong>Troubleshooting</strong></td>
</tr>
<tr>
<td></td>
<td>Error and maintenance messages ......................................................................... 115</td>
</tr>
<tr>
<td></td>
<td>Document jam ........................................................................................................... 118</td>
</tr>
<tr>
<td></td>
<td>Multi-feed ................................................................................................................. 120</td>
</tr>
<tr>
<td></td>
<td>Troubleshooting ....................................................................................................... 122</td>
</tr>
<tr>
<td>A</td>
<td><strong>Appendix A</strong></td>
</tr>
<tr>
<td></td>
<td>Specifications ........................................................................................................... 126</td>
</tr>
<tr>
<td></td>
<td>General ..................................................................................................................... 126</td>
</tr>
<tr>
<td></td>
<td>Scanner ..................................................................................................................... 129</td>
</tr>
<tr>
<td></td>
<td>Interfaces ................................................................................................................ 130</td>
</tr>
<tr>
<td></td>
<td>Supported languages ............................................................................................... 130</td>
</tr>
<tr>
<td></td>
<td>Computer requirements ............................................................................................ 131</td>
</tr>
</tbody>
</table>
Contact Brother .....................................................................................................................................132
Register your product online at .......................................................................................................132
Frequently Asked Questions (FAQs) .............................................................................................132
For customer service .....................................................................................................................133
For Brother accessories & supplies .............................................................................................133
Technical support (for PageManager) ..........................................................................................134
Choose your scanning software

After installing Brother’s scanner drivers, select a scanning application to save scanned images to your computer. Brother has supplied several options for you on Brother’s installation DVD; use this table to determine which of the included scanning applications will work best for you:

<table>
<thead>
<tr>
<th>Software</th>
<th>Description</th>
<th>Where is it?</th>
<th>For more information</th>
</tr>
</thead>
</table>
| **DS Capture**                  | Brother’s scanning application: it allows you to scan, browse and file your scanned documents. DS Capture is installed automatically when you install the scanner driver. | Windows®: DVD/Brother Solutions Center ¹ | For Windows®: See Scan using your computer on page 25.  
For Macintosh: See Scan using your computer on page 65 and Scan using the control panel on page 64). |
| **Button Manager V2**           | Use this application to extend the DS Capture scanning functionality, and to create multiple types of scan buttons to perform one-touch scanning. If scanning with your computer, click the button to which the required scan settings have been assigned with the application. If scanning with your machine, select the menu to which the required scan settings have been assigned on the LCD screen, and then press the machine’s Scan button.  
The following scan functions are supported:  
Scan to File/Scan to File (OCR)/Scan to App/E-mail/Printer/Shared Folder/FTP/SharePoint  
See the Button Manager Help menu for more information about using Button Manager V2. | DVD/Brother Solutions Center ¹ | See the Button Manager V2 User’s Guide.  
To scan using the Scan button on your machine’s control panel, customize the Scan button in advance (see Scan using the control panel on page 20). |
| **OmniPage SE 18**              | OmniPage SE 18 is an OCR scanning application from Nuance.                                       | DVD                               | See the software’s user instructions.                                                                                                                                 |
| **PageManager 9**               | PageManager 9 is a scanning application from NewSoft.                                            | Brother Solutions Center ¹        | See the software’s user instructions.                                                                                                                                 |

¹ Visit support.brother.com

**NOTE**

In addition to the above, you can also use your TWAIN (Windows®/Mac), WIA (Windows®), ISIS (Windows®) and ICA (Mac) compatible applications for scanning.
Scanner overview

1 Top Cover
2 Cover Extension
3 Document Guide Stopper
4 Document Guides
5 Automatic Document Feeder (ADF)
6 ADF Cover
7 Document Cover
8 Document Stopper
9 Flatbed
10 Control Panel
11 Cover Release Lever
12 Security Slot
13 USB 3.0 SuperSpeed Port
14 AC Power Port
15 Transport Lock
Control panel

Your Brother machine has one Liquid Crystal Display (LCD), five buttons and one Light Emitting Diode (LED) on the control panel. The LCD is a 16 character, two-line display.

Control panel overview

1 Liquid Crystal Display (LCD)
Displays messages to help you set up and use your machine.

2 Function Selector (▲ or ▼)
Press to scroll through the function numbers.
For more information about the function numbers, see Scan using the control panel on page 20, step 4 and 5.

3 Power button (LED)
• Press to turn the machine ON when the machine is off or in Power Saving Mode.
• Press to enter Power Saving Mode when the machine is ON.
• Press and hold down to turn the machine OFF.
For more information about Power Saving Mode, see Energy Saving Control on page 57.

4 Cancel button
Press to stop scanning.

5 Scan button
Press to start scanning or to launch a scanning application.
LED indications

The LED indicates your Brother machine’s status.

<table>
<thead>
<tr>
<th>LED Indication</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>No light</td>
<td>The machine is OFF.</td>
</tr>
<tr>
<td>Green</td>
<td>The machine is ON.</td>
</tr>
<tr>
<td>Blinking green</td>
<td>The machine is initializing or in Power Saving Mode.</td>
</tr>
<tr>
<td>Blinking red</td>
<td>There is a problem with the machine.</td>
</tr>
</tbody>
</table>

Machine status messages

The following table explains the machine’s status messages during normal operation:

<table>
<thead>
<tr>
<th>Machine Status Message</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function X</td>
<td>This shows the currently selected function number.</td>
</tr>
<tr>
<td>PageCount XXXXX</td>
<td>The machine is ready to scan.</td>
</tr>
<tr>
<td>Scanning XXXXX</td>
<td>The machine is scanning.</td>
</tr>
<tr>
<td>Canceling</td>
<td>The machine is cancelling the current scan job.</td>
</tr>
<tr>
<td>Where XXXXX is the document scan count.</td>
<td></td>
</tr>
<tr>
<td>Where XXXXX is the current document scan count.</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE**

When Button Manager is running on your computer, **Function X** changes to a Button Manager function number and name.

For more information, see the *Button Manager V2 User's Guide*. Go to your model’s page on the Brother Solutions Center at solutions.brother.com/manuals to download the *Button Manager V2 User's Guide*. 
### Acceptable documents

<table>
<thead>
<tr>
<th>Standard Paper</th>
<th>Length</th>
<th>ADF</th>
<th>2.13 in. to 14.0 in. (54 mm to 356 mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Scanner Glass</td>
<td>14.0 in. Maximum: (356 mm)</td>
</tr>
<tr>
<td></td>
<td>Width</td>
<td>ADF</td>
<td>2.0 in. to 8.58 in. (51 mm to 218 mm)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Scanner Glass</td>
<td>8.5 in. Maximum: (216 mm)</td>
</tr>
<tr>
<td></td>
<td>Weight</td>
<td>ADF</td>
<td>7.5 lb to 106 lb (28 g/m² to 400 g/m²)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To scan thinner documents, use the Carrier Sheet (see Loading documents using the Carrier Sheet in the ADF on page 16).</td>
<td></td>
</tr>
<tr>
<td>Maximum Number of Pages</td>
<td>ADF (Automatic Document Feeder)</td>
<td>100 sheets (with 28 to 80 g/m² paper)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>70 sheets (with 105 g/m² paper)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>60 sheets (with 127 g/m² paper)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>50 sheets (with 200 g/m² paper)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>15 sheets (with 400 g/m² paper)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>15 sheets (Business Card)</td>
<td></td>
</tr>
<tr>
<td>Standard Paper Size</td>
<td>A4</td>
<td>8.3 in. × 11.7 in. (210 mm × 297 mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A5</td>
<td>5.8 in. × 8.3 in. (148 mm × 210 mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A6</td>
<td>4.1 in. × 5.8 in. (105 mm × 148 mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A7</td>
<td>2.9 in. × 4.1 in. (74 mm × 105 mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>B5</td>
<td>7.2 in. × 10.1 in. (182 mm × 257 mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>B6</td>
<td>5.0 in. × 7.2 in. (128 mm × 182 mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>B7</td>
<td>3.6 in. × 5.0 in. (91 mm × 128 mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legal</td>
<td>8.5 in. × 14 in. (215.9 mm × 355.6 mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter</td>
<td>8.5 in. × 11 in. (215.9 mm × 279.4 mm)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Long Paper</th>
<th>Maximum Length</th>
<th>236.0 in. (5,994 mm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADF (Automatic Document Feeder)</td>
<td>Width</td>
<td>2.0 in. to 8.58 in. (51 mm to 218 mm)</td>
</tr>
<tr>
<td></td>
<td>Weight</td>
<td>7.5 lb to 106 lb (28 g/m² to 400 g/m²)</td>
</tr>
<tr>
<td></td>
<td>To scan thinner documents, use the Carrier Sheet (see Loading documents using the Carrier Sheet in the ADF on page 16).</td>
<td></td>
</tr>
<tr>
<td>Maximum Number of Pages</td>
<td>1 page (1 sheet)</td>
<td></td>
</tr>
</tbody>
</table>

¹ If scanning at 200 dpi
Unacceptable documents

- Documents with paper clips or staples
- Documents with wet ink
- Fabrics, metallic sheets, overhead projector sheets
- Glossy or mirrored media
- Embossed plastic cards
- Documents that exceed recommended thicknesses

**IMPORTANT**

The damage caused by using any unacceptable document with your Brother machine may not be covered under warranty.
Documents recommended for use with the Carrier Sheet (for ADF Scan)

NOTE
• You cannot place a Carrier Sheet onto the Flatbed’s scanner glass.
• To purchase a Carrier Sheet, find contact information for your local Brother office at www.brother.com
  U.S. users: find contact information for your local Authorized Service Center at www.brother-usa.com/service/

Use the optional Carrier Sheet when you scan the following:
- Plastic cards
- Documents with a carbon sheet attached
- Documents written in pencil
- Documents narrower than 2.0 in. (50 mm) wide
- Documents shorter than 2.13 in. (54 mm) long
- Documents of uneven thickness, such as envelopes
- Documents with large wrinkles or curls
- Bent or damaged documents
- Documents that use tracing paper
- Documents that use coated paper
- Photographs (photographic paper)
- Documents printed on perforated paper
- Documents printed on unusually-shaped paper (not square or rectangular)
- Documents with photos, notes, or stickers affixed to them
- Documents that use carbonless paper
- Documents that use loose-leaf paper or any paper with holes in it
- Photographic negatives
- Receipts

For more information about using the Carrier Sheet, see Loading documents using the Carrier Sheet in the ADF on page 16.

⚠️ CAUTION

To avoid cutting yourself, do not slide or scrape your hand or fingers along the edges of the Carrier Sheet.
Set up your machine for Automatic Document Feeder (ADF) use

1. Open the Top Cover (1), pull the Cover Extension (2) out, and then unfold the Document Guides (3).

2. Lift the Document Stopper (1) and slide it to fit the size of your paper.
Set up your machine for Flatbed use

1. Lift the document cover (1).

2. Make sure the scanner glass is empty.
Load documents

**IMPORTANT**
- The ADF can hold up to 100 pages and feeds each sheet individually. Use 20 lb (80 g/m²) paper and always fan the pages before placing them in the ADF.
- DO NOT pull on the document while it is feeding.
- DO NOT use paper that is curled, wrinkled, folded, ripped, stapled, paper-clipped, pasted, or taped.
- DO NOT try to scan cardboard or fabric.

**NOTE**
- Make sure the documents that have ink or correction fluid on them are completely dry.
- Certain types of plastic cards may be scratched when scanned. To prevent damage to the card, we recommend using the Carrier Sheet or scanner glass.
- If misfeeds frequently occur when you scan thin sheets, reduce the number of documents held in the ADF, and then start scanning again.

**Loading documents in the ADF**

1. Fan the pages several times along both the long edge and the short edge.
2 Adjust the Document Guides (1) to fit the width of your document.

NOTE
When scanning documents with punch holes, such as continuous form paper, slide the Document Guide Stopper (1) up, and then extend the Document Guide (2).
3. Place the pages, **face down, top edge first** in the ADF between the Guides until you feel them touch the inside of the machine.

- For plastic cards: Place your card, **face down** and **short side first** in the ADF between the Guides until you feel it touch the inside of the machine. Load only one plastic card at a time.
- For documents longer than Letter/A4 size: If the document is longer than the Top Cover, support the document with your hand. Load only one document at a time. See *Acceptable documents* on page 5.
Loading documents on the Flatbed’s scanner glass

1. Lift the document cover (1).

2. Place the document face down in the right corner of the scanner glass (1), as shown.

3. Close the document cover.
Loading multiple different-size documents in the ADF

NOTE
Make sure that the narrowest document is wide enough to touch the ADF’s feed rollers, or it may cause a document jam.

1. Stack the documents on top of each other, making sure that the top edge and the left side of each document are aligned.

2. Adjust the Document Guides (1) to fit the width of the largest document.

3. Place the documents, face down, top edge first in the ADF between the Guides until you feel them touch the inside of the machine.
## Combinations of multiple different-sized documents

<table>
<thead>
<tr>
<th></th>
<th>LTR (P)</th>
<th>A4 (P)</th>
<th>B5 (P)</th>
<th>A5 (P)</th>
<th>A6 (P)</th>
<th>B6 (P)</th>
<th>A7 (P)</th>
<th>B7 (P)</th>
<th>A8 (P)</th>
<th>B8 (P)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width (mm) (*1)</td>
<td>216</td>
<td>210</td>
<td>182</td>
<td>149</td>
<td>129</td>
<td>105</td>
<td>74.3</td>
<td>64.3</td>
<td>52.5</td>
<td></td>
</tr>
<tr>
<td>LTR (P) Carrier Sheet</td>
<td>216</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A4 (P)</td>
<td>210</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A5 (L)</td>
<td>182</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B5 (P)</td>
<td>182</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B6 (L)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A5 (P)</td>
<td>149</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A6 (L)</td>
<td>129</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B6 (P)</td>
<td>129</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B7 (L)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A6 (P)</td>
<td>105</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A7 (L)</td>
<td>91</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B7 (P)</td>
<td>91</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B8 (L)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A7 (P)</td>
<td>74.3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A8 (L)</td>
<td>64.3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B8 (P)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A8 (P)</td>
<td>52.5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

LTR: Letter size  
(P): Portrait  
(L): Landscape
Loading documents using the Carrier Sheet in the ADF

To purchase a Carrier Sheet, find contact information for your local Brother office at www.brother.com

IMPORTANT

• Do not write on the Carrier Sheet, as the writing may be seen in scanned documents. If the Carrier Sheet becomes dirty, wipe it with a dry cloth.

• Do not leave documents in the Carrier Sheet for extended periods of time, as the printing on the documents may bleed through onto the Carrier Sheet.

• Do not place the Carrier Sheet in direct sunlight or in an area subject to high temperatures and high humidity, as the Carrier Sheet may warp.

• Do not place large or heavy objects on the Carrier Sheet when it is lying flat.

• Do not bend or pull the Carrier Sheet. If it becomes damaged, it may not be acceptable for scanning - do not use it.

• Do not scan multiple Carrier Sheets in a row.

1 Insert the document into the Carrier Sheet.

NOTE

• Place the document in the center of the Carrier Sheet and align the top of the document with the top of the Carrier Sheet.

• To avoid document jams, do not put several small documents into the Carrier Sheet at the same time. Insert only one document into the Carrier Sheet at a time.
2. Adjust the Document Guides (1) to fit the width of the Carrier Sheet.

3. Place the Carrier Sheet in the ADF between the Guides until you feel it touch the inside of the machine.

**NOTE**
To avoid document jams, do not load the Carrier Sheet upside down.
Loading documents wider than Letter/A4 size

You can scan documents that are wider than Letter/A4 size using the Carrier Sheet. Before scanning, see *Loading documents using the Carrier Sheet in the ADF* on page 16 for basic usage instructions and notes about the Carrier Sheet.

1. For best results, carefully fold your document in half, making sure all the corners are even, and then insert the document into the Carrier Sheet.

2. Adjust the Document Guides (1) to fit the width of the Carrier Sheet.
3. Place the Carrier Sheet in the ADF between the Guides until you feel it touch the inside of the machine.

**NOTE**
To reduce the white space in the center of a scanned page, be sure to position the folded edge of the original document closer to the right edge of the Carrier Sheet.
Scan (Windows®)

Scan using the control panel

Customize the Scan button on your Brother machine’s control panel to scan using your preferred scanning software.

Assign a scanning application to the Scan button

1. Confirm that the machine is connected to your computer via a USB cable.
2. Access the machine from your computer using one of the following:
   - For Windows® 10
     Click (Start) > Settings > Devices > Printers&Scanners > Devices&Printers.
   - For Windows® 8/8.1
     Move your mouse to the lower right corner of your desktop. When the menu bar appears, click > Control Panel. In the Hardware and Sound group, click View devices and printers.
   - For Windows® 7
     Click (Start) > Devices and Printers.
   - For Windows Vista®
     Click (Start) > Control Panel > Scanners and Cameras > Printers.
3. Right-click the scanner icon, and select Scan properties from the menu.
   For Windows Vista®, select the machine and click Properties.
Click the **Events** tab, and then select an event number from the **Select an event** drop-down list. The **Button #** you select from this list directly corresponds with the function numbers (**Function X**) displayed on the machine’s LCD.
5. Select **Start this program** from **Actions**, and then select the scanning application you want to launch when you press the [Scan] button on your machine’s control panel.

![Properties window with selected actions](image)

6. Click **OK**.
7 Select the function number that you assigned to the scanning application on the machine’s LCD, and then push the (Scan) button on your machine to launch the assigned application.

NOTE
When you use Button Manager V2 application, you can synchronize the machine’s LCD and application’s function names by assigning Brother Button Manager to all the Button # in the Select an event drop-down list. For more information, see the Button Manager V2 User’s Guide.
Scan a document

1. Confirm that the machine is connected to your computer via a USB cable.
2. Place your document either in the ADF, or on the scanner glass.
3. Press ▲ or ▼ to select a Function.

NOTE
When Brother’s Button Manager is running on your computer, the machine’s LCD displays a Button Manager function number and name. For more information, see the Button Manager V2 User’s Guide.

4. Press to launch the scanning application.
5. Press again to begin scanning.
Scan (Windows®)

Scan using your computer

To scan using your computer, launch a TWAIN-compatible application on your computer, such as DS Capture or Adobe® PhotoShop®. This guide uses DS Capture as an example.

Scan with DS Capture

1. Confirm that the machine is connected to your computer via a USB cable.
2. Double-click the DS Capture icon on your desktop.

NOTE

If the DS Capture icon is not visible on your desktop, click Start > All Programs > Brother PDS-XXXX Scanner (where XXXX is your model name) > DS Capture.

3. The Select Scanner Model dialog box appears. Select your Brother machine’s model from the Scanner Model list, and then click OK.
DS Capture launches.

Click Setup to change the scan settings, if needed.
For more information on changing settings, see Change scan settings using the TWAIN driver on page 27.

Place your document either in the ADF, or on the scanner glass.

Click Scan. Your machine starts scanning.

A thumbnail of the scanned image appears in the DS Capture window and the scanned image is saved in the directory you specified in the Path field. For more information, see DS Capture home screen on page 28.

Check the scan result to confirm that all settings are correct.
Change scan settings using the TWAIN driver

The TWAIN driver provides various settings and useful functions, which you can use when scanning, as listed in the overview table below.

In this guide, we use the DS Capture application in our examples. Instructions for other scanning software should be similar.

Functional overview

<table>
<thead>
<tr>
<th>Category</th>
<th>Function</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic settings</strong></td>
<td>Specify the image type (color) and scan</td>
<td>Image tab on page 31</td>
</tr>
<tr>
<td></td>
<td>Automatically identify the document color and scan</td>
<td>Image tab on page 31</td>
</tr>
<tr>
<td></td>
<td>Specify the document size and scan</td>
<td>Paper tab on page 40</td>
</tr>
<tr>
<td></td>
<td>Automatically identify the document size and scan</td>
<td>Paper tab on page 40</td>
</tr>
<tr>
<td></td>
<td>Specify the resolution and scan</td>
<td>Image tab on page 31</td>
</tr>
<tr>
<td><strong>Image processing</strong></td>
<td>Remove the specified color and scan</td>
<td>Color Dropout tab on page 38</td>
</tr>
<tr>
<td></td>
<td>Rotate the document</td>
<td>Rotation tab on page 50</td>
</tr>
<tr>
<td></td>
<td>Detect and remove blank pages</td>
<td>Enhancement tab on page 52</td>
</tr>
<tr>
<td></td>
<td>Remove punch holes of scanned documents</td>
<td>Enhancement tab on page 52</td>
</tr>
<tr>
<td></td>
<td>Automatically compensate the document tilt</td>
<td>Paper tab on page 40</td>
</tr>
<tr>
<td></td>
<td>Remove the document base color</td>
<td>Enhancement tab on page 52</td>
</tr>
<tr>
<td></td>
<td>Add a white or black edge around the border</td>
<td>Enhancement tab on page 52</td>
</tr>
<tr>
<td></td>
<td>Remove small dots or specks from the background</td>
<td>Enhancement tab on page 52</td>
</tr>
<tr>
<td><strong>Efficient scanning</strong></td>
<td>See preview and check scan settings</td>
<td>Preview tab on page 47</td>
</tr>
<tr>
<td></td>
<td>Save your scanner properties</td>
<td>Image tab on page 31</td>
</tr>
<tr>
<td></td>
<td>Acquire multiple color type scan results with a single scan</td>
<td>Image tab on page 31</td>
</tr>
<tr>
<td></td>
<td>Specify the computer memory used when scanning</td>
<td>More Settings tab on page 56</td>
</tr>
<tr>
<td></td>
<td>Perform consecutive document scanning</td>
<td>Paper tab on page 40</td>
</tr>
<tr>
<td><strong>Advanced functions</strong></td>
<td>Scan a barcode to read information</td>
<td>Enhancement tab on page 52</td>
</tr>
<tr>
<td></td>
<td>Add a character string to the scan result</td>
<td>Digital Imprinter tab on page 58</td>
</tr>
<tr>
<td></td>
<td>Divide a 1 page document into 2 pages</td>
<td>Rotation tab on page 50</td>
</tr>
<tr>
<td></td>
<td>Scan a document larger than Letter/A4 size</td>
<td>Image tab on page 31</td>
</tr>
<tr>
<td><strong>Machine settings</strong></td>
<td>Specify multifeed detection settings</td>
<td>Multi-Feed Detection tab on page 45</td>
</tr>
<tr>
<td></td>
<td>Check and reset the scan count</td>
<td>Information tab on page 62</td>
</tr>
<tr>
<td></td>
<td>Change the Power Saving Mode and Power Off time settings</td>
<td>More Settings tab on page 56</td>
</tr>
<tr>
<td><strong>System information</strong></td>
<td>Check the scanner and computer system information</td>
<td>Information tab on page 62</td>
</tr>
</tbody>
</table>
DS Capture home screen

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
</table>
| (1) | Fast scan mode / Fast display mode (select from the File menu) | Switch the scan mode if needed.  
  ■ Fast scan mode  
  Fast scan mode gives priority to scanning speed. Thumbnails are displayed after scanning is complete.  
  ■ Fast display mode  
  In Fast display mode, thumbnails are displayed in real-time.      | Fast scan mode   |
<p>|     | Debug (select from the File menu)              | Set the debug value between 0 and 9.                                                                                                              | 0              |
|     |                                                | <strong>NOTE</strong>                                                                                                                                            |                 |
|     |                                                | When you select Fast display mode, scanning speed may be slower, depending on your computer.                                                      |                 |
| (2) | Setup                                          | Change scanner properties. For more information, see Scanner Properties dialog box on page 30.                                                      | -              |</p>
<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(3)</td>
<td>Scan</td>
<td>Click this button to scan.</td>
<td>-</td>
</tr>
</tbody>
</table>
| (4) | File Format           | Change the file format.
Select the format you want from the drop-down list.                                                                                     | JPEG     |
|     |                       | **NOTE**
To save multiple documents as one file, select
Multi-page PDF (MPDF) or Multi-page TIFF (MTIFF)
from the drop-down list.                                                                                          |          |
| (5) | Path                  | Specify the directory where you want to save scanned images.                                                                                  | \My Documents\My Scan\ |
| (6) | Fit Page              | View and resize the scanned image.
You cannot use Fit Page when PDF or Multi-page PDF is selected in File Format.                                                                | (selected) |
| (7) | Actual Size (100%)    | View the scanned image in Actual Size (100%).
You cannot use Actual Size (100%) when PDF or Multi-page PDF is selected in File Format.                                                 | (not selected) |
Scanner Properties dialog box

Click **Setup** on the DS Capture home screen to display the **Scanner Properties** dialog box.

Use the **Scanner Properties** tabs to configure your Brother machine’s settings.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Tabs</td>
<td>Image, Compression, Color Dropout, Paper, Multi-Feed Detection, Preview, Rotation, Enhancement, More Settings, Digital Imprinter, Information</td>
</tr>
<tr>
<td>(2)</td>
<td>Defaults</td>
<td>Click <strong>Defaults</strong> to reset all settings in all tabs to factory settings.</td>
</tr>
</tbody>
</table>
| (3) | Scan/OK | Click the **Scan** button to start a scan.  
Click **OK** to save the settings and close the **Scanner Properties** dialog box. |
| (4) | Cancel | Click **Cancel** to close the **Scanner Properties** dialog box without saving changes. |

**NOTE**

All settings in the **Image** tab (except for the **Resolution**), the **Compression** tab, the **Color Dropout** tab, and the **Preview** tabs can be set individually for the front and back of any double-sided document you scan.
Image tab

Click the Image tab to set basic scan settings, to assign values for the front or back of your document and to specify the image type.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Image Selection check boxes</td>
<td>Select the check boxes to specify the type of scan for the front (and back) of your document.</td>
<td>Front B&amp;W</td>
</tr>
<tr>
<td>(2)</td>
<td>Image Selection group</td>
<td>Customize the settings for the front and back of your document.</td>
<td>Front B&amp;W</td>
</tr>
<tr>
<td>(3)</td>
<td>Binarization / Document Type / Non-Color Selection</td>
<td>Select an appropriate image processing mode. This field name changes based on your choice in the Image Selection group.</td>
<td>Dynamic Threshold / Document / Black and White</td>
</tr>
<tr>
<td>(4)</td>
<td>Sensitivity / Threshold</td>
<td>Change sensitivity/threshold value.</td>
<td>-</td>
</tr>
<tr>
<td>(5)</td>
<td>Brightness</td>
<td>Change brightness.</td>
<td>0</td>
</tr>
<tr>
<td>(6)</td>
<td>Contrast</td>
<td>Change contrast.</td>
<td>0</td>
</tr>
<tr>
<td>(7)</td>
<td>Resolution (dpi)</td>
<td>Select resolution.</td>
<td>200</td>
</tr>
<tr>
<td>(8)</td>
<td>Invert</td>
<td>Reverse the brightness and the colors in the image.</td>
<td>Black on White</td>
</tr>
<tr>
<td>(9)</td>
<td>Scan Source options</td>
<td>Select a scan source.</td>
<td>Automatic</td>
</tr>
<tr>
<td>(10)</td>
<td>Profiles</td>
<td>Create or change scan profiles for frequently used scan settings.</td>
<td>Custom</td>
</tr>
<tr>
<td>(11)</td>
<td>Color Profile</td>
<td>Ensure accurate colors when scanning.</td>
<td>Document</td>
</tr>
</tbody>
</table>
Image Selection check boxes

Select the check boxes to set the color mode for both the front and the back of your document. For example, to scan both the front and back of a color document page in color, select the Front Color and Back Color check boxes. For a black and white scan of the front and a color scan of the back, select Front B&W and Back Color.

NOTE

- Select more than one image type check box to generate multiple scan results from a single scan. For example, if you select Front Color and Front Gray, and then scan your document, scan data in both color and gray is saved.
- If you select Front Auto Color Detection, you must select Back Auto Color Detection as a back image type (and the other way round). These two options work only with each other.
- Back Auto Color Detection, Back Color, Back Gray and Back B&W is not available when using the scanner glass.

Image Selection group

The Image Selection group lets you configure detailed settings used when scanning in each color mode. Select an image type and customize detailed settings. You can apply different settings to each image type.

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Select Color if your original is in color and you want an exact copy.</td>
</tr>
<tr>
<td>Gray</td>
<td>Select Gray if your original contains shades of gray.</td>
</tr>
<tr>
<td>B&amp;W</td>
<td>Select B&amp;W if your original is typed, written in pencil, or written in pen.</td>
</tr>
<tr>
<td>Auto Color Detection</td>
<td>Select Auto Color Detection to automatically detect and scan the front or back of your color document. If your document is in color, the machine automatically scans the document as a color image. If your document is not in color, select either Black and White or Gray from the Non-Color Selection drop-down list. Use this option if your document is multi-page and includes both color and black and white.</td>
</tr>
</tbody>
</table>

Binarization / Document Type / Non-Color Selection

This field name changes based on your choice in the Image Selection group.

- **Binarization (B&W mode only)**

  Binarization is the process of converting a grayscale or color image into a black and white image. There are several methods of performing this conversion.

<table>
<thead>
<tr>
<th>Conversion Methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Threshold</td>
<td>Select Dynamic Threshold to allow the machine to dynamically evaluate each document to produce the highest quality image. Select this option to scan documents containing faint text, shaded background, or color background. If you select Dynamic Threshold: Threshold, Brightness, and Contrast are not available.</td>
</tr>
<tr>
<td>Fixed Processing</td>
<td>Select Fixed Processing for black and white and other high-contrast documents. A single level is set to determine the black and white transition. The threshold is programmable over the entire density range. If you select Fixed Processing, Contrast is not available.</td>
</tr>
<tr>
<td>Halftone 1-5</td>
<td>Select Halftone to view a gray image composed of different-sized dots. In other machines, this is sometimes called “Grayscale”.</td>
</tr>
</tbody>
</table>
When you select **Gray** as the image type for your scanned document, you can choose from three document types:

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Document</strong></td>
<td>Select <strong>Document</strong> if your original contains only text or a mixture of text and graphics. This is the optimal setting for regular business documents.</td>
</tr>
<tr>
<td><strong>Photo</strong></td>
<td>Select <strong>Photo</strong> if your original contains a photograph, to reproduce it in a vivid grayscale image.</td>
</tr>
<tr>
<td><strong>Normal</strong></td>
<td>Select <strong>Normal</strong> to adjust <strong>Brightness</strong> and <strong>Contrast</strong> manually.</td>
</tr>
</tbody>
</table>

**Non-Color Selection (Auto Color Detection mode only)**

If your document is non-color, you can choose the output to be either **Black and White** or **Gray**. This option is useful when you scan a combination of color and non-color documents.

Select **Error Diffusion** for a type of Halftone. **Error Diffusion** results in good image texture and makes text in images more legible than **Halftone 1-5** above.
Sensitivity / Threshold

- **Sensitivity** (available when you select Dynamic Threshold or Auto Color Detection)
  
  Sensitivity of Dynamic Threshold:
  If your document contains small dots or speckles and you want to remove them, increase the sensitivity value by moving the bar to the right.
  
  Sensitivity of Auto Color Detection:
  If your document contains primarily black and white text with a small amount of light or pale color that you do not want to be recognized as color, reduce the sensitivity value by moving the bar to the left.

- **Threshold** (available when you select Fixed Processing or Document)
  
  A low threshold value produces a lighter image, and can be used to subdue backgrounds and unneeded information. A high threshold value produces darker images, and can be used to help faint images stand out.

Brightness

Use the **Brightness** bar to lighten or darken an image. The greater the value, the clearer the image.

Contrast

Use the **Contrast** bar to adjust the range between the darkest and the lightest shades in the image. The greater the value, the greater the difference between light and dark.

Resolution (dpi)

Select a resolution value from the drop-down list. The greater the value, the higher the resolution, and larger the file size.

You can set a custom resolution value by clicking the ![...](image) button to the right of the drop-down list.

Invert

Use **Invert** to reverse the brightness and the colors in the image. The default setting is **Black on White** background. To reverse this, select **White on Black**.

Scan Source

- **Automatic**
  
  The machine uses the paper from the ADF first. If there is no paper in the ADF, the machine switches to Flatbed scanning.
Automatic Document Feeder (ADF)
Use the ADF to scan multiple pages.

Flatbed
Use the scanner glass to scan.

2 in 1 for Automatic Document Feeder
Use 2 in 1 to scan documents wider than Letter/A4 size. The machine scans both sides of the folded document, and merges the images onto a single page.

- Merge Vertically check box
  Select this check box to align both sides vertically.
  Clear this check box to align both sides horizontally.

Profiles
Click Profiles to save your frequently-used scan settings.
To create a scan profile:

1. Select your scan settings in the Scanner Properties dialog box, using any of the tabs.

2. When finished, click the Image tab, and then click Profiles.
   The Edit Your Profile dialog box appears.
Scan (Windows®)

3 Click Add..., and then type the name of the profile you want to save.

4 Click Save.
   The new profile is added to the Profiles drop-down list.

NOTE
   You can Delete, Rename, or Reset profile names in the Edit Your Profile dialog box.

Color Profile
Use the Color Profile settings to achieve accurate color reproduction for scans. This option uses the default ICC profile parameters to adjust the image colors. ICC profiles are used with color mapping, mainly in digital photography and printing.

- **Document**
  Select Document if your original contains only text or a mixture of text and graphics. This is an optimal setting for regular business documents.

- **None**
  Select None to disable the Color Profile option.

- **Photo**
  Select Photo if your document contains photos, and you want to reproduce your photos in vivid color.

- **Mix**
  Select Mix if your document contains a combination of text and graphics. The Mix option offers mid-range scan quality between Document and Photo.
**Compression tab**

Click the **Compression** tab to reduce the scanned image size but maintain image quality.

**NOTE**

The Compression options available may differ depending on the scanning application you use.

---

![Compression tab interface](image)

(1) **Compression**
(2) **JPEG Quality**

---

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Compression</td>
<td>Select a Compression mode.</td>
<td>None</td>
</tr>
<tr>
<td>(2)</td>
<td>JPEG Quality</td>
<td>Change the JPEG quality.</td>
<td>50</td>
</tr>
</tbody>
</table>

**Compression**

To following compression types are available:

<table>
<thead>
<tr>
<th>Available Compression Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color or Gray Images</td>
</tr>
<tr>
<td>None</td>
</tr>
<tr>
<td>JPEG</td>
</tr>
</tbody>
</table>

**JPEG Quality**

Move the **JPEG Quality** slider to the right or left to increase or decrease the level of compression. The greater the **JPEG Quality** percentage value, the larger the file size.
**Color Dropout tab**

Click the **Color Dropout** tab to remove the red, blue, or green color from your scanned image resulting in a gray or black and white document.

**NOTE**

*Color Dropout* is available only when you select **Gray** or **B&W** from the Image Selection group.

If your image contains a red watermark or background, select the **Red** channel to remove any red watermark or background color. This feature is useful for sharpening text when using Optical Character Recognition (OCR) software.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td><strong>Remove Color</strong></td>
<td>Select the color you want to remove from your scan.</td>
<td><strong>None</strong></td>
</tr>
<tr>
<td>(2)</td>
<td><strong>Advanced Processing</strong></td>
<td>Configure the advanced settings when removing a color.</td>
<td>(not selected)</td>
</tr>
</tbody>
</table>
When you select **Custom** from the **Remove Color** drop-down menu, the **Color Dropout** tab changes as follows:

![Color Dropout Tab](image)

**Remove Color**

Select one of the following from the **Remove Color** drop-down list:

- **None**
  - No color is removed.

- **Remove Red / Remove Green / Remove Blue**
  - Removes red, green, or blue from the scan.

- **Custom**
  - See **Custom settings** on page 39.

**Advanced Processing**

Select the **Advanced Processing** check box to adjust the details that can optimize your scan result.

- **Mode**
  - Select **Quality** to configure detailed settings for the **Filter Threshold** value. **Mode** is available only when **Remove Red, Remove Green, Remove Blue**, or **Automatic** is selected in the **Remove Color** drop-down list.

- **Filter Threshold**
  - This value determines how much color to remove. A lower value removes more of the selected color, while a higher value keeps more of the selected color. **Filter Threshold** is available only when **Quality** is selected in the **Mode** drop-down list.

**Custom settings**

Select **Custom** in the **Remove Color** drop-down list to specify the exact color you want to remove by entering its RGB (Red, Green, and Blue) value or by selecting it in the Color palette.

- **RGB values**
  - Displays the RGB value for the color selected in the Color palette. Adjust RGB values manually, if needed.

- **Color palette**
  - To manually specify the color you want to remove, click that color in the palette. The RGB value of the selected color appears in **RGB values**.
Click the **Paper** tab to define values relating to image output and auto scan.

**No.** | **Name** | **Description** | **Default** |
--- | --- | --- | --- |
(1) | Cropping | Capture a portion of the document being scanned. | Automatic (Deskew ON) |
(2) | Carrier Sheet Mode | Select this check box if using the Carrier Sheet. | (not selected) |
(3) | Scan Area / Page Size | Select the paper size. | ISO A4 - 210 mm x 297 mm |
(4) | Portrait / Landscape | Select your scanned document's layout. | Portrait |
(5) | X-Offset / Y-Offset / Width / Length / Center | Adjust the scanning area manually. | - |
(6) | OverScan / Adjustment | Add a specific margin at the top and bottom of the edge of the image. | 0.00 |
(7) | Background Settings | Select a background color. | White Background |
(8) | Unit | Select the unit of measurement displayed in the **Scanner Properties** window. | (based on language) |
(9) | Reload Timeout | Set the amount of time the machine has to wait before starting an auto scan after the first scan job is completed. | 0 |
Cropping

Cropping allows you to capture a portion of the document being scanned. Options include:

- **Automatic (Deskew ON)**
  This option automatically adjusts the cropping window according to document size. Use this option for batches of mixed-sized documents.

- **Fixed Area (Deskew OFF)**
  This option allows you to define the area or zone to be captured. Use it when scanning batches of same-sized documents. If you select this option, type numerical values, or use the up or down arrow keys to define the x and y offset values, width and length of your scan area.

- **EOP (End of Page) Detection (Deskew OFF)**
  This option allows you to define the area or zone to be captured. Use it when scanning batches of same-width but different-length documents. If you select this option, type numerical values, or use the up or down arrow keys to define the x and y offset values, width, and length of your scan area.

- **Relative to Document (Deskew OFF)**
  This option allows you to crop different areas of your documents and deliver these images in black and white, gray, or color separately. Use it if you are working with an application that requires you to store the entire document in black and white and a part of the document in color to save storage space. This is useful for documents where a photograph or signature appears in the same area on each document.

**NOTE**

- When you select **Automatic (Deskew ON)**, scanned images are automatically deskewed if the images are crooked.
- **Punch Hole Removal** is not available when Automatic Cropping is disabled.
Auto Crop (Flatbed Only): multi image output

This option allows you to automatically scan to the multiple files when you place multiple documents on the scanner glass at the same time.

NOTE

Only available when Scan Source is set to Flatbed.

Limitation of Auto Crop (Flatbed Only): multi image output

- A minimum distance between objects is 0.5 in.
- Objects must be at least 1 inch in size.
- If you set Automatic (Deskew ON), it will be scanned as shown in the illustration.
Carrier Sheet Mode
Select this check box if using the Carrier Sheet.

NOTE
• Carrier Sheet Mode is available only when Automatic (Deskew ON) is selected from the Cropping drop-down list.
• Carrier Sheet Mode is not available when using the scanner glass.

Scan Area / Page Size
This field name changes based on your selection in the Cropping drop-down list.
Select the paper size you want from the drop-down list:
- None
- US Legal - 8.5 in. × 14 in.
- US Letter - 8.5 in. × 11 in.
- Photo - 6 in. × 4 in.
- Photo - 5 in. × 3 in.
- ISO A4 - 210 mm × 297 mm
- ISO A5 - 148 mm × 210 mm
- ISO A6 - 105 mm × 148 mm
- ISO A7 - 74 mm × 105 mm
- ISO B5 - 176 mm × 250 mm
- ISO B6 - 125 mm × 176 mm
- ISO B7 - 88 mm × 125 mm
- JIS B5 - 182 mm × 257 mm
- JIS B6 - 128 mm × 182 mm
- JIS B7 - 91 mm × 128 mm
- Maximum Scan Length
- Long Page (< 236 in. [5,994 mm])
- Custom \(^1\)

\(^1\) Available after adding a Custom setting (see below).
\(^2\) If scanning at 200 dpi, the document length that can be scanned may vary with the resolution.

Custom
Click the button to add or change a custom paper size. To apply the custom settings, select Custom from the Scan Area / Page Size drop-down list.

NOTE
Long Page in the Scan Area drop-down list is not available when using the scanner glass.
Portrait / Landscape

NOTE

Landscape cannot be selected when US Legal, US Letter, A4, B5, Maximum Scan Length, or Long Page is selected.

X-Offset / Y-Offset / Width / Length / Center

When you select Fixed Area (Deskew OFF) from the Cropping drop-down list, you can adjust the scan area manually using the following values:

- **X-Offset**
  Adjusts the distance from the left edge of the scanner to the left edge of the area in your document.

- **Y-Offset**
  Adjusts the distance from the top edge of the document to the top edge of the area in your document.

- **Width**
  Adjusts the width of the area in your document.

- **Length**
  Adjusts the length of the area in your document.

- **Center**
  Allows the software to automatically center the scanned image based on the selected paper size.

OverScan / Adjustment

Allows you to add a specific margin at the top and bottom of the edge of the image. This is used to reduce possible corner clipping on skewed images and is often applied to a batch of skewed documents. Select a value between 0 in. and 0.18 in. (4.5 mm).

Background Setting

Select White Background or Black Background from the drop-down list to set the background color for your scanned images.

NOTE

This option is available only when you select Automatic (Deskew ON) in the Cropping drop-down list.

Unit

Select Millimeters, Inches, or Pixels from the drop-down list. The default setting is based on your OS language.

Reload Timeout

Set the amount of time the machine has to wait before auto-scanning the next document after a scan job is completed. Use this feature if you load many separate documents, which must be scanned using the same scan settings, in the ADF.
Multi-Feed Detection tab

Click the Multi-Feed Detection tab to detect pages that overlap when fed through the ADF. A multifeed usually occurs due to stapled documents, adhesives on documents, or electrostatically charged documents.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Additional Length Detection</td>
<td>Define the page length if it exceeds the scan area.</td>
<td>(not selected)</td>
</tr>
<tr>
<td>(2)</td>
<td>Ultrasonic Detection</td>
<td>Detect overlapped pages by measuring paper thickness.</td>
<td>(not selected)</td>
</tr>
<tr>
<td>(3)</td>
<td>Display window</td>
<td>Display a preview of Additional Length Detection.</td>
<td>-</td>
</tr>
<tr>
<td>(4)</td>
<td>Stop Scanning after Multi-Feed</td>
<td>Stop the ADF and display a warning when a multifeed is detected.</td>
<td>(not selected)</td>
</tr>
<tr>
<td>(5)</td>
<td>Multi-Feed Alarm</td>
<td>Customize an alarm sound if a multifeed occurs.</td>
<td>C:\Windows\Media\ding.wav</td>
</tr>
<tr>
<td>(6)</td>
<td>Unit</td>
<td>Select the unit of measurement displayed in the Scanner Properties window.</td>
<td>(based on language)</td>
</tr>
</tbody>
</table>

**NOTE**

Multi-Feed Detection tab is not available when using the scanner glass.
Additional Length Detection
Allows you to define the length of document being scanned by specifying the additional length exceeding scan area. The Display window displays the size of the page as you change the value. A value of “0” indicates no additional length detection. Use the Additional Length Detection feature when scanning multiple same-sized documents from the ADF. If you select this detection method, scanning does not stop even if a multifeed is detected.

Ultrasonic Detection
Detects overlapping pages by measuring paper thickness. When this feature is selected, and your machine detects a multifeed, scanning stops immediately and a warning message appears on your computer monitor.

Display window
Displays a preview of the Additional Length Detection value. When this feature is selected, and your machine detects a multifeed, scanning stops immediately and a warning message appears on your computer monitor.

Stop Scanning after Multi-Feed
Select this check box to stop the feeder and display the warning dialog box when a multifeed is detected.

NOTE
This option is available only when you select Additional Length Detection.

Multi-Feed Alarm
Use this feature to set an audible alarm emitted when a multifeed occurs. To change the alarm sound, click Browse... and select a wave file from your computer.

NOTE
• This feature is available when either Additional Length Detection or Ultrasonic Detection is selected.
• The alarm field supports the .wav file format only.

Unit
Select Millimeters, Inches, or Pixels from the drop-down list. The default setting is based on your OS language.
Preview tab

Click the *Preview* tab to display a low-resolution preview of your image before the final scan. The preview image helps to determine your scan area and check your color processing results.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Scan Area</td>
<td>Select the paper size.</td>
<td>ISO A4 - 210 mm x 297 mm</td>
</tr>
<tr>
<td>(2)</td>
<td>Portrait / Landscape</td>
<td>Select the scanned document’s layout.</td>
<td>Portrait</td>
</tr>
<tr>
<td>(3)</td>
<td>Display window</td>
<td>Display a preview of your scanned image or set your scan area manually.</td>
<td>-</td>
</tr>
<tr>
<td>(4)</td>
<td>X-Offset / Y-Offset / Width / Length</td>
<td>Adjust your scan area manually.</td>
<td>-</td>
</tr>
<tr>
<td>(5)</td>
<td>Unit</td>
<td>Select the unit of measurement displayed in the <em>Scanner Properties</em> window.</td>
<td>(based on language)</td>
</tr>
<tr>
<td>(6)</td>
<td>Selected area applies to all modes</td>
<td>Apply the same scan area settings to all documents.</td>
<td>(not selected)</td>
</tr>
<tr>
<td>(7)</td>
<td>Preview</td>
<td>Preview your scan.</td>
<td>-</td>
</tr>
</tbody>
</table>
NOTE

Scan Area, Portrait / Landscape, Display window, X-Offset / Y-Offset / Width / Length and Unit are disabled under the following settings:

• When Cropping is set to Automatic (Deskew ON) in the Paper tab (see Paper tab on page 40).
• When Cropping is set to Fixed Area (Deskew OFF) and Scan Area is set to Long Page in the Paper tab (see Paper tab on page 40).

Scan Area

Select the paper size you want from the drop-down list:
- None
- US Legal - 8.5 in. × 14 in.
- US Letter - 8.5 in. × 11 in.
- Photo - 6 in. × 4 in.
- Photo - 5 in. × 3 in.
- ISO A4 - 210 mm × 297 mm
- ISO A5 - 148 mm × 210 mm
- ISO A6 - 105 mm × 148 mm
- ISO A7 - 74 mm × 105 mm
- ISO B5 - 176 mm × 250 mm
- ISO B6 - 125 mm × 176 mm
- ISO B7 - 88 mm × 125 mm
- JIS B5 - 182 mm × 257 mm
- JIS B6 - 128 mm × 182 mm
- JIS B7 - 91 mm × 128 mm
- Maximum Scan Length

Portrait / Landscape

NOTE

Landscape cannot be selected when US Legal, US Letter, A4, B5, Maximum Scan Length, or Long Page is selected.

Display window

Displays a preview of your scanned image.
You can set your scan area by placing your cursor in the Display window and dragging it diagonally to resize the outline.
X-Offset / Y-Offset / Width / Length
You can adjust the scan area manually using the following values:

■ X-Offset
Adjust the distance from the left edge of the scanner to the left edge of the area in the document that you want to scan.

■ Y-Offset
Adjust the distance from the top edge of the document to the top edge of the area in the document that you want to scan.

■ Width
Adjust the width of the area in the document that you want to scan.

■ Length
Adjust the length of the area in the document that you want to scan.

Unit
Select Millimeters, Inches, or Pixels from the drop-down list. The default setting is based on your OS language.

Selected area applies to all modes
Select the Selected area applies to all modes check box to use the same scan area settings for all documents.

Preview
Click Preview to display a low-resolution preview in the Display window.
Rotation tab

Click the Rotation tab to change values related to image rotation.

![Rotation tab screenshot]

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Rotation Degrees</td>
<td>Rotate the scanned image.</td>
<td>None</td>
</tr>
<tr>
<td>(2)</td>
<td>Split Image</td>
<td>Split the scanned image horizontally or vertically.</td>
<td>None</td>
</tr>
<tr>
<td>(3)</td>
<td>Flip Side Rotation</td>
<td>Change the orientation of the reverse side of the output page.</td>
<td>Book</td>
</tr>
<tr>
<td>(4)</td>
<td>Mirror</td>
<td>Reverse the right and left sides of your image.</td>
<td>(not selected)</td>
</tr>
</tbody>
</table>

Rotation Degrees

To rotate the scanned image, select the rotation angle from the drop-down list:

- None
- 90 degrees CW (Clockwise)
- 90 degrees CCW (Counter-clockwise)
- 180 degrees
- Auto Orientation

If you select Auto Orientation, the machine automatically rotates your document based on its contents.
**Split Image**
When you split an image, the machine creates two separate images aligned either horizontally or vertically. This is useful for documents containing an image that spans two pages, because you can save both images as a single image on a single page.

- **None**
- **Horizontal**
  - Divide a single image in half horizontally.
- **Vertical**
  - Divide a single image in half vertically.

**Flip Side Rotation**

- **Book**
  - Maintain the same image orientation on the reverse side of the output page.
- **Fanfold**
  - Rotate the image orientation 180 degrees on the reverse side of the output page.

**NOTE**
- *Flip Side Rotation* is available only when you set *Image Selection* options to scan both front and back of your document in the *Image* tab.
- *Flip Slide Rotation* is not available when using the scanner glass.

**Mirror**
Select the **Mirror** check box to reverse the right and left sides of your image.
Enhancement tab

Click the Enhancement tab to improve the appearance of your scanned image.

No. | Name                  | Description                                      | Default                  
--- |-----------------------|--------------------------------------------------|--------------------------
(1) | Punch Hole Removal    | Remove punch hole markings.                      | (not selected)           
(2) | Background Setting    | Remove or smoothen the background color.         | None                     
(3) | Edge Fill             | Add a white or black edge around the border.     | White, Millimeters: 0    
(4) | Despeckle             | Remove small dots or specks from the background. | Noise Number: 0, Noise Radius: 1 
(5) | Blank Page Removal    | Remove any blank pages from the original document.| (not selected)            
(6) | Barcode Detection     | Detect and recognize barcodes.                   | (not selected)           

![Image of Scanner Properties window with Enhancement tab options](image-url)
Punch Hole Removal

Select the **Punch Hole Removal** check box to remove punch hole markings on scanned images. This feature removes the punch hole markings by filling hole marks with the surrounding color.

![Original vs Punch Hole Removal](image)

**NOTE**

Punch Hole Removal is not available when **Automatic Cropping** is disabled.

Background Setting

Specifying the **Background Setting** allows you to remove or smoothen the base color of scanned documents.

- **Background Processing**
  - Select **None**, **Smooth** or **Removal** from the drop-down list. **Smooth** makes the background smooth, and **Removal** removes the background color.

- **Sensitivity**
  - Move the **Sensitivity** slider to the left or right to adjust the sensitivity to base color or background. The greater the sensitivity value, the better the scan results, the slower the scanning speed.

- **Mode**
  - This option is available only if you select **Smooth** under **Background Processing** above. Select **Auto** to allow the software to process the image automatically. Select **Moire** to reduce moire.

- **Fill Color**
  - This option is available only if you select **Removal** under **Background Processing** above. Select **White** to make the background white. Select **Auto** to allow the software to detect the background color automatically and fill it in with the color.
Edge Fill

Select **White** or **Black** and set a value (in **Millimeters**) to add a white or black edge around the border of your scanned image.
Select the **Edge Extend** check box to add a white or black edge outside the border of your scanned image.

**NOTE**

- The maximum edge fill value equals half the length of the shorter side of a selected scan area.
  For example, if you select Letter size, which is 8.5 × 11 in., the maximum value for the white edge or black edge is 4.25 in. (or half of 8.5 in.). If you select an A4 size, which is 210 × 297 mm, the maximum value for the white edge or black edge is 105 mm (half of 210 mm).
- If you set a value greater than the maximum allowed, the value automatically defaults to the maximum.
- To disable this feature, set the value to “0”.

![Original](image1.png)  ![Edge Fill: 20 mm (Black)](image2.png)  ![Edge Fill: 20 mm (Black) Edge Extend: Selected](image3.png)
**Despeckle**

This function allows you to remove small dots or speckles called “noise,” from the background of scanned images. Removing unwanted speckles provides a clear image for OCR processing, and helps to reduce compressed file sizes.

Define the noise you want to remove by specifying *Noise Number* (size) and *Noise Radius* (range).

![Before Despeckle](image1.png) ![After Despeckle](image2.png)

Before Despeckle  
(Noise Number: 0, Noise Radius: 1)  

After Despeckle  
(Noise Number: 22, Noise Radius: 10)

**NOTE**

*Despeckle* is available for black and white images only.

**Blank Page Removal**

Select the *Blank Page Removal* check box to remove blank pages from your scanned image. Move the slider to change the threshold, or level of pixels, that determines a blank page.

**Barcode Detection**

Select the *Barcode Detection* check box to split multi-page scanned files whenever a barcode is detected. An *avbarcode.ini* file containing the barcodes types is created and stored on your system drive, for example,  
*C:\ProgramData\PDS-XXXX\avbarcode.ini* (where XXXX is your model name).

**Select Barcode Type**

Click *Select Barcode Type* and select the barcode types to specify the barcode you want the scanning software to recognize.
More Settings tab

Click the **More Settings** tab to configure additional scanning options.

![Scanner Properties dialog box](image)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Cache</td>
<td>Assign a specified amount of memory from the available RAM to process the image data.</td>
<td>Memory Size</td>
</tr>
<tr>
<td>(2)</td>
<td>Energy Saving Control</td>
<td>Change settings related to energy saving.</td>
<td>Energy Saver: 15 minutes, Power Off: 240 minutes</td>
</tr>
<tr>
<td>(3)</td>
<td>Show Scanning Progress</td>
<td>Select to display the scanning progress bar during scanning.</td>
<td>(selected)</td>
</tr>
<tr>
<td>(4)</td>
<td>Show Warning Message</td>
<td>Select to display warning messages.</td>
<td>(selected)</td>
</tr>
<tr>
<td>(5)</td>
<td>Save Settings after Closing</td>
<td>Select to save all settings when you close the <strong>Scanner Properties</strong> dialog box.</td>
<td>(selected)</td>
</tr>
</tbody>
</table>

**NOTE**

This item is displayed only when using a TWAIN-compliant application, such as OmniPage.
Cache
This option allows you to assign a specified amount of memory from the available RAM to process the image data. By specifying a smaller memory size, you free more memory for other applications you are running. By specifying a larger memory size, you have more memory to process the image data, which is useful especially when you have a large number of documents to scan.

- **None**
  Select None from the Mode drop-down list to specify the number of pages to scan. For example, to scan only the first two pages of a document, move the page slider to 2.

- **Page Number**
  Select Page Number to limit your cache size by the number of scanned pages it contains. For reference, a Letter/A4 color document scanning at 300 dpi consumes approximately 24 MB.

- **Memory Size**
  Select Memory Size to limit your cache size by memory size. The amount of available memory depends on your computer.

**NOTE**
Cache is not available when using the scanner glass.

Energy Saving Control

- **Enable Energy Saver** (Power Saving Mode)
  Move the slider to set the amount of idle time before the machine enters Power Saving Mode.

- **Enable Power Off**
  Select the Enable Power Off check box and move the slider to set the amount of idle time before the machine automatically powers off.

**NOTE**
- You cannot disable Enable Energy Saver.
- If you clear the Enable Power Off check box, your machine will not power off automatically.
- Power Off time must be greater than or equal to Energy Saver time.

Show Scanning Progress
Select the Show Scanning Progress check box to display the scanning progress bar during scanning.

Show Warning Message
Select the Show Warning Message check box to display warning messages. If the rollers are near their end-of-life period, a warning message appears once per day until you reset the Reverse Roller Count and Pick-up and Separation Roller Count.

Save Settings after Closing
Select the Save Settings after Closing check box to save your settings when you close the Scanner Properties dialog box. The next time you open the Scanner Properties dialog box, the previous settings will appear.

**NOTE**
This item is displayed only when using a TWAIN-compliant application, such as OmniPage.
Digital Imprinter tab

Click the Digital Imprinter tab to print the date, time, document count, or custom messages on your scanned image.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Digital Imprinter</td>
<td>Select to activate this feature.</td>
<td>(not selected)</td>
</tr>
<tr>
<td>(2)</td>
<td>Print All</td>
<td>Print on every page of the scanned image.</td>
<td>(selected)</td>
</tr>
<tr>
<td>(3)</td>
<td>Custom</td>
<td>Type the custom text to print on your scanned image.</td>
<td>(none)</td>
</tr>
<tr>
<td>(4)</td>
<td>Counter</td>
<td>Change the scan counter.</td>
<td>Number (such as 1234)</td>
</tr>
<tr>
<td>(5)</td>
<td>Date/Time</td>
<td>Change the date/time.</td>
<td>None</td>
</tr>
<tr>
<td>(6)</td>
<td>Custom Font</td>
<td>Select a font.</td>
<td>Normal</td>
</tr>
<tr>
<td>(7)</td>
<td>Font Attributes</td>
<td>Select a font attribute.</td>
<td>Normal</td>
</tr>
<tr>
<td>(8)</td>
<td>String Orientation</td>
<td>Select the print direction.</td>
<td>Normal</td>
</tr>
<tr>
<td>(9)</td>
<td>Print Position</td>
<td>Select a print position.</td>
<td>Middle</td>
</tr>
<tr>
<td>(10)</td>
<td>Sample</td>
<td>Preview your custom text.</td>
<td>(none)</td>
</tr>
<tr>
<td>(11)</td>
<td>More</td>
<td>Set advanced font settings.</td>
<td>Size: 5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Density: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Transparency: 0</td>
</tr>
</tbody>
</table>
Digital Imprinter
Select the Digital Imprinter check box to use the digital imprinter to print custom text on your scanned image.

Print All
Select the Print All check box to print the text on every page of the scanned image. Clear the check box to print the text only on the first page of the scanned image.

Custom
Type the text you want in your print string (up to 31 characters).

Counter
Click to increase the scan counter.

The number of digits specified here is displayed on the scanned image. For example, selecting Number (123456) causes "000001" to be shown on the first page of the scanned image, "000002" on the second, "000003" on the third, and so forth.

Date/Time
Select Date, Time, or Date+Time to include the date or time in your print string.
Click to select a date or time separator from the drop-down list.

Custom Font
Select Normal or Fixed Width from the Custom Font drop-down list. Fixed Width (monospace) fonts use fixed character spacing, so each character occupies the same width.

Font Attributes
Select Normal, Underline, Double, or Bold from the Font Attributes drop-down list.
String Orientation
Select Normal, Rotated, Vertical, Vertical Inversion, 90 Degrees CW (clockwise), or 90 Degrees CCW (counter-clockwise) from the String Orientation drop-down list to specify the text’s print direction.

Print Position
Select Top, Middle, Bottom, or Custom from the Position drop-down list. If you select Custom, enter the X Offset and Y Offset value to specify the text’s start position.

Sample
Preview your text here.
More
Click the More button to select additional font properties.

- **Size**
  Move the slider to select font size (Default: 5).
- **Density**
  Move the slider to select font density (Default: 0).
- **Transparency**
  Move the slider to select a transparency value from 0% (not transparent) to 100% (completely transparent). This is useful when creating a partially transparent watermark.
Information tab

Click the Information tab to display system and machine information, such as scanner driver version and firmware version. You can also view the roller count and reset the count in this window.

![Diagram of Scanner Properties window]

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Reset Roller</td>
<td>Reset the roller count.</td>
<td>-</td>
</tr>
<tr>
<td>(2)</td>
<td>Report</td>
<td>Generate a report.txt file.</td>
<td>-</td>
</tr>
</tbody>
</table>

Reset Roller

After replacing the scanner rollers, click the Reset Roller button to reset the roller count.

**NOTE**

Do not reset the counter unless you have replaced the rollers.

Report

Click the Report button to generate a report.txt file that is stored on the system drive (for example, C:\XXXX <where XXXX is your scanner model>). Use this text file for troubleshooting when you encounter an error message (see Troubleshooting on page 115), or share this file with service personnel if you contact them via phone or email for troubleshooting support.
Scan using the ISIS driver

Applications compatible with the ISIS driver allow you to set the scan settings.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Mode</td>
<td>Select a scan type, such as black and white, gray, or color.</td>
</tr>
<tr>
<td>(2)</td>
<td>Dither</td>
<td>Select one of five halftone levels.</td>
</tr>
<tr>
<td>(3)</td>
<td>Dots per inch</td>
<td>Select the resolution you want.</td>
</tr>
<tr>
<td>(4)</td>
<td>Page Size</td>
<td>Select the page size you want.</td>
</tr>
<tr>
<td>(5)</td>
<td>Brightness</td>
<td>Adjust the brightness of your scanned image.</td>
</tr>
<tr>
<td>(6)</td>
<td>Contrast</td>
<td>Adjust the range between the darkest and the lightest shades in the image.</td>
</tr>
<tr>
<td>(7)</td>
<td>Default</td>
<td>Click to reset all settings to the factory settings.</td>
</tr>
<tr>
<td>(8)</td>
<td>Area</td>
<td>Select the scan area or position you want.</td>
</tr>
<tr>
<td>(9)</td>
<td>More</td>
<td>Click to reverse image, set multifeed detection and specify color drop-out.</td>
</tr>
</tbody>
</table>
64

6

Scan (Macintosh)

Scan using the control panel

Customize the (Scan) button on your Brother machine’s control panel to scan using your preferred scanning software.

Assign a profile to the Scan button

1. Confirm that the machine is connected to your computer via a USB cable.
2. Launch DS Capture, and click the Profile tab.
3. Click the Event pop-up list, and select an event number. The Button # you select from this list directly corresponds with the function numbers (Function X) displayed on the machine’s LCD.

Scan a document

1. Confirm that the machine is connected to your computer via a USB cable.
2. Place your document either in the ADF, or on the scanner glass.
3. Launch DS Capture.
4. Press ▲ or ▼ to select a Function.
5. Press (Φ) to start scanning.
Scan (Macintosh)

Scan using your computer

To scan using your computer, launch a TWAIN-compatible application on your computer, such as DS Capture or Adobe® PhotoShop®. This guide uses DS Capture as an example.

Scan with DS Capture

1. Confirm that the machine is connected to your computer via a USB cable.
2. Double-click the (DS Capture) icon on your desktop.
3. DS Capture launches.

![DS Capture screen]

4. Change the scanning settings, if needed. For more information on changing settings, see Change scan settings using the TWAIN driver on page 66.
5. Place your document either in the ADF, or on the scanner glass.
6. Click Scan in the DS Capture screen. Your machine starts scanning. The scanned image is saved in the directory you specified in the File tab. For more information, see File tab on page 75. Check the scan result to confirm that all settings are correct.
Change scan settings using the TWAIN driver

The TWAIN driver provides various settings and useful functions, which you can use when scanning, as listed in the overview table below.

In this guide, we use the DS Capture application in our examples. Instructions for other scanning software should be similar.

Functional overview

<table>
<thead>
<tr>
<th>Category</th>
<th>Function</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic settings</strong></td>
<td>Specify the image type (color) and scan</td>
<td><em>Image tab</em> on page 69</td>
</tr>
<tr>
<td></td>
<td>Automatically identify the document color and scan</td>
<td><em>Image tab</em> on page 69</td>
</tr>
<tr>
<td></td>
<td>Specify the document size and scan</td>
<td><em>Paper tab</em> on page 79</td>
</tr>
<tr>
<td></td>
<td>Automatically identify the document size and scan</td>
<td><em>Paper tab</em> on page 79</td>
</tr>
<tr>
<td></td>
<td>Specify the resolution and scan</td>
<td><em>Image tab</em> on page 69</td>
</tr>
<tr>
<td><strong>Image processing</strong></td>
<td>Remove the specified color and scan</td>
<td><em>Color Dropout tab</em> on page 77</td>
</tr>
<tr>
<td></td>
<td>Rotate the document</td>
<td><em>Rotation tab</em> on page 84</td>
</tr>
<tr>
<td></td>
<td>Detect and remove blank pages</td>
<td><em>Enhancement tab</em> on page 86</td>
</tr>
<tr>
<td></td>
<td>Remove punch holes of scanned documents</td>
<td><em>Enhancement tab</em> on page 86</td>
</tr>
<tr>
<td></td>
<td>Automatically compensate the document tilt</td>
<td><em>Paper tab</em> on page 79</td>
</tr>
<tr>
<td></td>
<td>Remove the document base color</td>
<td><em>Enhancement tab</em> on page 86</td>
</tr>
<tr>
<td></td>
<td>Add a white or black edge around the border</td>
<td><em>Enhancement tab</em> on page 86</td>
</tr>
<tr>
<td></td>
<td>Remove small defects, due to dust or scratches, from a scanned image</td>
<td><em>Enhancement tab</em> on page 86</td>
</tr>
<tr>
<td><strong>Efficient scanning</strong></td>
<td>See preview and check scan settings</td>
<td><em>DS Capture screen overview</em> on page 67</td>
</tr>
<tr>
<td></td>
<td>Save your scanner properties</td>
<td><em>Image tab</em> on page 69</td>
</tr>
<tr>
<td></td>
<td>Acquire multiple color type scan results with a single scan</td>
<td><em>Image tab</em> on page 69</td>
</tr>
<tr>
<td></td>
<td>Specify the computer memory used when scanning</td>
<td><em>Setting tab</em> on page 90</td>
</tr>
<tr>
<td></td>
<td>Perform consecutive document scanning</td>
<td><em>Paper tab</em> on page 79</td>
</tr>
<tr>
<td><strong>Advanced functions</strong></td>
<td>Add a character string to the scan result</td>
<td><em>Imprinter tab</em> on page 91</td>
</tr>
<tr>
<td></td>
<td>Divide a 1 page document into 2 pages</td>
<td><em>Rotation tab</em> on page 84</td>
</tr>
<tr>
<td></td>
<td>Scan a document larger than Letter/A4 size</td>
<td><em>Image tab</em> on page 69</td>
</tr>
<tr>
<td><strong>Machine settings</strong></td>
<td>Specify multifeed detection settings</td>
<td><em>Paper tab</em> on page 79</td>
</tr>
<tr>
<td></td>
<td>Check and reset the scan count</td>
<td><em>Information tab</em> on page 95</td>
</tr>
<tr>
<td></td>
<td>Change the Power Saving Mode and Power Off time settings</td>
<td><em>Setting tab</em> on page 90</td>
</tr>
<tr>
<td><strong>System information</strong></td>
<td>Check the scanner and computer system information</td>
<td><em>Information tab</em> on page 95</td>
</tr>
</tbody>
</table>
DS Capture screen overview

Launch the TWAIN user interface using your scanning software. This guide uses the DS Capture user interface to explain the TWAIN user interface.
Click the tab menus to configure your Brother machine’s settings.

![DS Capture screen overview](image)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Tabs</td>
<td>Profile, Image, File, Color Dropout, Paper, Rotation, Enhancement, Setting, Imprinter, Information</td>
</tr>
<tr>
<td>(2)</td>
<td>Default</td>
<td>Click Default to reset all settings in all tabs to factory settings.</td>
</tr>
<tr>
<td>(3)</td>
<td>Scan</td>
<td>Click Scan to start scanning.</td>
</tr>
<tr>
<td>(4)</td>
<td>Exit</td>
<td>Click Exit to close the window.</td>
</tr>
<tr>
<td>(5)</td>
<td>Preview Window</td>
<td>Click to show or hide the image preview window, containing a low-resolution preview of your image, before your final scan.</td>
</tr>
</tbody>
</table>

**NOTE**

All settings in the Image tab (except for the Resolution), and the Color Dropout tab can be set individually for the front and back of any double-sided document you scan.
Profile tab

Click the Profile tab to assign specific scan profiles to specific buttons on your Brother machine’s control panel.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Profile</td>
<td>View all scan profiles saved in DS Capture. Click a Profile to view its settings in the Description field.</td>
<td>-</td>
</tr>
<tr>
<td>(2)</td>
<td>Event</td>
<td>Select a button number from the pop-up list. The Button # you select from this list directly corresponds with the function numbers (Function X) displayed on the machine’s LCD.</td>
<td>-</td>
</tr>
<tr>
<td>(3)</td>
<td>Description</td>
<td>View the selected scan profile’s settings.</td>
<td>-</td>
</tr>
</tbody>
</table>

**NOTE**

You must assign an event number to scan using the Scan button on the machine. For more information, see Scan using the control panel on page 64.
Image tab

Click the Image tab to set basic scan settings, to assign values for the front or back of your document and to specify the image type.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Image Selection check boxes</td>
<td>Select the check boxes to specify the type of scan for the front (and back) of your document.</td>
<td>Front B&amp;W</td>
</tr>
<tr>
<td>(2)</td>
<td>Image Selection group</td>
<td>Customize the settings for the front and back of your document.</td>
<td>Front B&amp;W</td>
</tr>
<tr>
<td>(3)</td>
<td>Binarization / Document Type</td>
<td>Select an appropriate image processing mode. This field name changes based on your choice in the Image Selection group.</td>
<td>Dynamic Threshold / Document</td>
</tr>
<tr>
<td>(4)</td>
<td>Sensitivity / Threshold</td>
<td>Change sensitivity/threshold value.</td>
<td>(none)</td>
</tr>
<tr>
<td>(5)</td>
<td>Brightness</td>
<td>Change brightness.</td>
<td>0</td>
</tr>
<tr>
<td>(6)</td>
<td>Contrast</td>
<td>Change contrast.</td>
<td>0</td>
</tr>
<tr>
<td>(7)</td>
<td>Resolution</td>
<td>Select resolution.</td>
<td>200</td>
</tr>
<tr>
<td>(8)</td>
<td>Invert</td>
<td>Reverse the brightness and the colors in the image.</td>
<td>Black on White</td>
</tr>
<tr>
<td>(9)</td>
<td>Scan Source</td>
<td>Select a scan source.</td>
<td>Automatic</td>
</tr>
<tr>
<td>(10)</td>
<td>Page Size</td>
<td>Capture a portion of the document being scanned.</td>
<td>Automatic</td>
</tr>
<tr>
<td>(11)</td>
<td>Profile</td>
<td>Create or change scan profiles for frequently used scan settings.</td>
<td>Custom</td>
</tr>
<tr>
<td>(12)</td>
<td>Color Profile</td>
<td>Ensure accurate colors when scanning.</td>
<td>Document</td>
</tr>
</tbody>
</table>
Image Selection check boxes
Select the check boxes to set the color mode for both the front and the back of your document. For example, to scan both the front and back of a color document page in color, select the Front Color and Back Color check boxes. For a black and white scan of the front and a color scan of the back, select Front B&W and Back Color.

NOTE
• Select more than one image type check box to generate multiple scan results from a single scan. For example, if you select Front Color and Front Gray, and then scan your document, scan data in both color and gray is saved.
• If you select Front Auto Detection, you must select Back Auto Detection as a back image type (and the other way round). These two options work only with each other.
• Back Auto Detection, Back Color, Back Gray and Back B&W is not available when using the scanner glass.

Image Selection group
The Image Selection group lets you configure detailed settings used when scanning in each color mode. Select an image type and customize detailed settings. You can apply different settings to each image type.

<table>
<thead>
<tr>
<th>Image Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Select Color if your original is in color and you want an exact copy.</td>
</tr>
<tr>
<td>Gray</td>
<td>Select Gray if your original contains shades of gray.</td>
</tr>
<tr>
<td>B&amp;W</td>
<td>Select B&amp;W if your original is typed, written in pencil, or written in pen.</td>
</tr>
<tr>
<td>Auto Detection</td>
<td>Select Auto Detection to automatically detect and scan the front or back of your color document. If your document is in color, the machine automatically scans the document as a color image. If your document is not in color, select either Black and White or Gray from the Non-Color Selection pop-up list. Use this option if your document is multi-page and includes both color and black and white.</td>
</tr>
</tbody>
</table>

Binarization / Document Type
This field name changes based on your choice in the Image Selection group.

Binarization (B&W mode only)
Binarization is the process of converting a grayscale or color image to a black and white image. There are several methods of performing this conversion.

<table>
<thead>
<tr>
<th>Conversion Methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Threshold</td>
<td>Select Dynamic Threshold to allow the machine to dynamically evaluate each document to produce the highest quality image. Select this option to scan documents containing faint text, shaded background, or color background. If you select Dynamic Threshold: Threshold, Brightness, and Contrast are not available.</td>
</tr>
<tr>
<td>Fixed Processing</td>
<td>Select Fixed Processing for black and white and other high-contrast documents. A single level is set to determine the black and white transition. The threshold is programmable over the entire density range. If you select Fixed Processing, Contrast is not available.</td>
</tr>
<tr>
<td>Halftone 1-5</td>
<td>Select Halftone to view a gray image composed of different-sized dots. In other machines, this is sometimes called “Grayscale”.</td>
</tr>
</tbody>
</table>
When you select Gray as the image type for your scanned document, you can choose from three document types:

<table>
<thead>
<tr>
<th>Document Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document</td>
<td>Select Document if your original contains only text or a mixture of text and graphics. This is the optimal setting for regular business documents.</td>
</tr>
<tr>
<td>Photo</td>
<td>Select Photo if your original contains a photograph, to reproduce it in a vivid grayscale image.</td>
</tr>
<tr>
<td>Normal</td>
<td>Select Normal to adjust Brightness and Contrast manually.</td>
</tr>
</tbody>
</table>

- **Document Type (Gray mode only)**

When you select **Gray** as the image type for your scanned document, you can choose from three document types:

<table>
<thead>
<tr>
<th>Conversion Methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Error Diffusion</strong></td>
<td>Select <strong>Error Diffusion</strong> for a type of Halftone. <strong>Error Diffusion</strong> results in good image texture and makes text in images more legible than <strong>Halftone 1-5</strong> above.</td>
</tr>
</tbody>
</table>

![Halftone](image1) ![Diffusion](image2)

**Document** (Threshold: 230)  **Photo**  **Normal**
Sensitivity / Threshold

- Sensitivity (available when you select Dynamic Threshold)
  If your document contains small dots or speckles and you want to remove them, increase the sensitivity value by moving the bar to the right.

- Threshold (available when you select Fixed Processing or Document)
  A low threshold value produces a lighter image, and can be used to subdue backgrounds and unneeded information. A high threshold value produces darker images, and can be used to help faint images stand out.

Brightness
Use the Brightness bar to lighten or darken an image. The greater the value, the clearer the image.

Contrast
Use the Contrast bar to adjust the range between the darkest and the lightest shades in the image. The greater the value, the greater the difference between light and dark.

Resolution
Select a resolution value from the pop-up list. The greater the value, the higher the resolution, and larger the file size.
You can type a custom resolution value in the Resolution field.

Invert
Use Invert to reverse the brightness and the colors in the image. The default setting is Black on White background. To reverse this, select White on Black.

Scan Source

- Automatic
  The machine uses the paper from the ADF first. If there is no paper in the ADF, the machine switches to Flatbed scanning.

- Automatic Document Feeder (ADF)
  Use the ADF to scan multiple pages.

- Flatbed
  Use the scanner glass to scan.
2 in 1 for Automatic Document Feeder

Use 2 in 1 to scan documents wider than Letter/A4 size. The machine scans both sides of the folded document, and merges the images onto a single page.

- **Merge Vertically** check box

  Select this check box to align both sides vertically. Clear this check box to align both sides horizontally.

![Diagram showing document merging](image)

Select **Merge Vertically**

Clear **Merge Vertically**

**Page Size**

Select the paper size you want from the pop-up list:

- Automatic
- Auto Crop (Flatbed Only): multi image output
- US Legal - 8.5 in. × 14 in.
- US Letter - 8.5 in. × 11 in.
- Photo - 6 in. × 4 in.
- Photo - 5 in. × 3 in.
- ISO A4 - 210 mm × 297 mm
- ISO A5 - 148 mm × 210 mm
- ISO A6 - 105 mm × 148 mm
- ISO A7 - 74 mm × 105 mm
- ISO B5 - 176 mm × 250 mm
- ISO B6 - 125 mm × 176 mm
- ISO B7 - 88 mm × 125 mm
- JIS B5 - 182 mm × 257 mm
- JIS B6 - 128 mm × 182 mm
- JIS B7 - 91 mm × 128 mm
- Maximum Scan Length
- Long Page (< 236 in. [5,994 mm] ¹)
- Custom

¹ If scanning at 200 dpi, the document length that can be scanned may vary with the resolution.
NOTE

**Auto Crop(Flatbed Only): multi image output** is only available when Scan Source is set to **Automatic** or **Flatbed**.

**Profile**

Click **Profile** to save your frequently used scan settings.

To create a scan profile:

1. Select your scan settings using any of the tabs.
2. When finished, click the **Image** tab, and then click the button on the right of the **Profile** field. The *Add A New Profile* dialog box appears.

3. Type the name of the profile you want to save.
4. Click **OK**.

The new profile appears in the **Profile** field and in the **Profile** pop-up list.

**NOTE**

- To delete a profile, select the profile from the pop-up list, click the button, and click **OK**.
- To edit a profile, enter the name of the profile you want to edit in the *Add a New Profile* dialog box and click **OK**.

**Color Profile**

Use the **Color Profile** settings to achieve accurate color reproduction for scans. This option uses the default ICC profile parameters to adjust the image colors. ICC profiles are used with color mapping, mainly in digital photography and printing.

- **Document**
  Select **Document** if your original contains only text or a mixture of text and graphics. This is an optimal setting for regular business documents.

- **None**
  Select **None** to disable the **Color Profile** option.

- **Photo**
  Select **Photo** if your document contains photos, and you want to reproduce your photos in vivid color.

- **Mix**
  Select **Mix** if your document contains a combination of text and graphics. The **Mix** option offers mid-range scan quality between **Document** and **Photo**.
File tab

Click the **File** tab to set the directory path, file name and file format of your scanned images.

---

**Directory**

Specify where you want to save scanned images. Click the **Browse** button to navigate to the directory where you want to save scanned images, or type a file location in the **Directory** field. The default directory is `/Users/xxx/Documents` (where `xxx` is your user name).

**File Name options**

Specify the default file name of scanned images. You can customize the default file name using text and special symbols.

- **File Name**
  - Type a file name using any text and any of the codes shown. For example, to name all scans “User1” with the month and year (that is, “User1-December, 2014”), type `User1-%MM%YYYY` in the **File Name** field.

- **Digits**
  - Select the number of digits. This setting is available when `%SEQ` is set.

- **Sample**
  - Displays an example of your file name.

---

**When file names are the same**

Select an operation to execute if the same file name exists in the directory. The default setting is **Increase sequence number**.

**File Format**

Select the file format you want. The default file format is JPEG (*.jpg).

**Scan to**

Select where to automatically send the scanned image. The default setting is **File**.
When file names are identical
Choose an automatic action for the scanning software to execute if file names are duplicated in your default directory:

- **Increase sequence number**
  - Increase the sequence number of the new scanned image file, and save both new and old files.

- **Overwrite always**
  - Save only the new scanned image and overwrite the old one.

- **Ask User**
  - Display a dialog box that prompts you to either increase the sequence number of the new file or overwrite the old file.

File Format
Select the file format you want from the pop-up list.

To save multiple documents as one file, select the **Multi Page Output** check box.

Scan to
Select **File**, **Application**, **E-mail**, or **Printer** from the pop-up list to specify where to send the scanned image file.

Select the **Show in Finder** check box to open the Finder and display the directory where the image is saved.
Color Dropout tab

Click the Color Dropout tab to remove the red, blue, or green color from your scanned image resulting in a gray or black and white document. If your image contains a red watermark or background, select the Red channel to remove any red watermark or background color. This feature is useful for sharpening text when using Optical Character Recognition (OCR) software.

NOTE

This function supports only black and white or gray documents.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Color Dropout</td>
<td>Select the color you want to remove from your scan.</td>
<td>None</td>
</tr>
<tr>
<td>(2)</td>
<td>Advanced Processing</td>
<td>Configure the advanced settings when removing a color.</td>
<td>(not selected)</td>
</tr>
<tr>
<td>(3)</td>
<td>Preview Result</td>
<td>Preview the result of current color dropout settings in the image preview window.</td>
<td>-</td>
</tr>
<tr>
<td>(4)</td>
<td>Color Picker</td>
<td>Select the dropout color from the preview image.</td>
<td>-</td>
</tr>
</tbody>
</table>

Color Dropout

Select one of the following from the Color Dropout pop-up list:

■ None
  No color is removed.

■ Remove Red / Remove Green / Remove Blue
  Removes red, green, or blue from the scan.

■ Custom
  Manually adjust the RGB value of the color you want to remove, or select the dropout color from the preview image using Color Picker 🖌️.
Advanced Processing
Select the Advanced Processing check box to adjust the details that can optimize your scan result.

■ Mode
Select Quality to configure detailed settings for the filter threshold value. Mode is available only when Remove Red, Remove Green, Remove Blue, or Automatic is selected in the Remove Color pop-up list.

■ Filter Threshold (available when you select None, Remove Red, Remove Green, or Remove Blue)
This value determines how much color to remove. A lower value removes more of the selected color, while a higher value keeps more of the selected color. Filter Threshold is available only when Quality is selected in the Mode pop-up list.

■ RGB values (available when you select Custom)
Displays the RGB value for the color selected in the image preview window. Adjust RGB values manually, if needed.

Preview Result
Click this button to preview your color dropout settings. Before using this feature you must preview your image by clicking the Preview Window button.

Color Picker
The Color Picker option is available only if you select Custom under Color Dropout, and only after you preview your image by clicking the Preview Window button. Select the dropout color from the preview image.
Click the button, move the mouse over the preview image, and click the color you want to remove. The RGB values for the selected color automatically populate the Red, Green and Blue fields.
Click the **Paper** tab to define values relating to image output, overlapping pages, and auto scan.

![Diagram showing the Paper tab settings](image)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Page Size</td>
<td>Capture a portion of the document being scanned. If you select <strong>Automatic</strong>, scanned images are automatically deskewed if they are crooked.</td>
<td>Automatic</td>
</tr>
<tr>
<td>(2)</td>
<td>Unit</td>
<td>Select the unit of measurement displayed from the available options.</td>
<td>(based on language)</td>
</tr>
<tr>
<td>(3)</td>
<td>Carrier Sheet Mode</td>
<td>Select this check box if using the Carrier Sheet.</td>
<td>(not selected)</td>
</tr>
<tr>
<td>(4)</td>
<td>Portrait / Landscape</td>
<td>Select your scanned document’s layout.</td>
<td>Portrait</td>
</tr>
<tr>
<td>(5)</td>
<td>X-Offset / Y-Offset / Width / Length</td>
<td>Adjust the scanning area manually.</td>
<td>-</td>
</tr>
<tr>
<td>(6)</td>
<td>Multi-Feed Detection options</td>
<td>Configure the options to detect documents that overlap when fed through the ADF.</td>
<td>OFF</td>
</tr>
<tr>
<td>(7)</td>
<td>Reload Timeout</td>
<td>Set the amount of time the machine has to wait before starting an auto scan after the first scan job is completed.</td>
<td>0</td>
</tr>
</tbody>
</table>
Page Size
Select the paper size you want from the pop-up list:

- Automatic
- Auto Crop (Flatbed Only): multi image output
- US Legal - 8.5 in. × 14 in.
- US Letter - 8.5 in. × 11 in.
- Photo - 6 in. × 4 in.
- Photo - 5 in. × 3 in.
- ISO A4 - 210 mm × 297 mm
- ISO A5 - 148 mm × 210 mm
- ISO A6 - 105 mm × 148 mm
- ISO A7 - 74 mm × 105 mm
- ISO B5 - 176 mm × 250 mm
- ISO B6 - 125 mm × 176 mm
- ISO B7 - 88 mm × 125 mm
- JIS B5 - 182 mm × 257 mm
- JIS B6 - 128 mm × 182 mm
- JIS B7 - 91 mm × 128 mm
- Maximum Scan Length
- Long Page (< 236 in. [5,994 mm] \(^1\))
- Custom

\(^1\) If scanning at 200 dpi, the document length that can be scanned may vary with the resolution.
**Automatic**

This option automatically adjusts the cropping window according to document size. Use this option for batches of mixed-sized documents.

![Automatic Cropping Diagram](image)

**NOTE**

- When you select **Automatic**, scanned images are automatically deskewed if the images are crooked.
- **Punch Hole Removal** is not available when Automatic Cropping is disabled.

**Auto Crop (Flatbed Only): multi image output**

This option allows you to automatically scan to the multiple files when you place multiple documents on the scanner glass at the same time.

![Auto Crop Diagram](image)
NOTE
Only available when Scan Source is set to Flatbed.
Limitation of Auto Crop (Flatbed Only): multi image output
- A minimum distance between objects is 0.5 in.
- Objects must be at least 1 inch in size.
- If you set Automatic, it will be scanned as shown in the illustration.

Unit
Select Millimeters, Inches, or Pixels from the pop-up list. The default setting is based on your OS language.

Carrier Sheet Mode
Select this check box if using the Carrier Sheet.

NOTE
- This option is available only when Automatic is selected in the Page Size pop-up list.
- Carrier Sheet Mode is not available when using the scanner glass.

Portrait / Landscape

NOTE
- Landscape cannot be selected when US Legal, US Letter, A4, B5, Maximum Scan Length, or Long Page is selected.
X-Offset / Y-Offset / Width / Length
You can adjust the scan area manually using the following values:

- **X-Offset**
  Adjusts the distance from the left edge of the scanner to the left edge of the area in the document that you want to scan.

- **Y-Offset**
  Adjusts the distance from the top edge of the document to the top edge of the area in the document that you want to scan.

- **Width**
  Adjusts the width of the area in the document that you want to scan.

- **Length**
  Adjusts the length of the area in the document that you want to scan.

Multi-Feed Detection options
Configure the Multi-Feed Detection options to detect documents that overlap when fed through the ADF. A multifeed usually occurs due to stapled documents, adhesives on documents, or electrostatically charged documents.

- **Additional Length Detection**
  Allows you to define the length of document being scanned by specifying the additional length exceeding scan area. A value of “0” indicates no additional length detection. Use the Additional Length Detection feature when scanning multiple same-sized documents from the ADF. If you select this detection method, scanning does not stop even if a multifeed is detected.

- **Ultrasonic Detection**
  Detects overlapping pages by measuring paper thickness. When this feature is selected, and your machine detects a multifeed, scanning stops immediately and a warning message appears on your computer monitor.

- **Stop Scanning after Multi-Feed**
  Select this check box to stop the feeder and display the warning dialog box when a multifeed is detected.

**NOTE**
- This option is available when you select Additional Length Detection.
- To stop scanning immediately when a multifeed is detected, select the Stop Scanning after Multi-Feed check box.

- **Multi-Feed Alarm**
  Use this feature to set an audible alarm emitted when a multifeed is detected. To change the alarm sound, click Browse... and select a wave file from your computer.

**NOTE**
- This feature is available when either Additional Length Detection or Ultrasonic Detection is selected.

Reload Timeout
Set the amount of time the machine has to wait before auto-scanning the next document after the scan job is completed. Use this feature if you load many separate documents, which must be scanned using the same scan settings, in the ADF.
Rotation tab

Click the Rotation tab to set specifications related to image rotation.

To rotate the scanned image, select the rotation angle from the pop-up list:

- None
- 90 degrees CW (Clockwise)
- 180 degrees
- 90 degrees CCW (Counter-clockwise)
- Auto based on contents

If you select Auto based on contents, the machine automatically rotates your document based on its contents.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Rotation Degrees</td>
<td>Rotate the scanned image.</td>
<td>None</td>
</tr>
<tr>
<td>(2)</td>
<td>Split Image</td>
<td>Split the scanned image horizontally or vertically.</td>
<td>None</td>
</tr>
<tr>
<td>(3)</td>
<td>Mirror</td>
<td>Reverse the right and left sides of your image.</td>
<td>(not selected)</td>
</tr>
</tbody>
</table>
Split Image

When you split an image, the machine creates two separate images aligned either horizontally or vertically. This is useful for documents containing an image that spans two pages, because you can save both images as a single image on a single page.

- **None**
- **Horizontal**
  - Divide a single image in half horizontally.
- **Vertical**
  - Divide a single image in half vertically.

Mirror

Select the **Mirror** check box to reverse the right and left sides of your image.
Enhancement tab

Click the Enhancement tab to improve the appearance of your scanned image.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Punch Hole Removal</td>
<td>Remove punch hole markings.</td>
<td>(not selected)</td>
</tr>
<tr>
<td>(2)</td>
<td>Background Setting</td>
<td>Remove or smoothen the background color.</td>
<td>None</td>
</tr>
<tr>
<td>(3)</td>
<td>Edge Fill</td>
<td>Add a white or black edge around the border.</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Millimeters: 0</td>
</tr>
<tr>
<td>(4)</td>
<td>Despeckle</td>
<td>Remove small dots or speckles from the background.</td>
<td>Noise Number: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Noise Radius: 1</td>
</tr>
<tr>
<td>(5)</td>
<td>Blank Page Removal Threshold</td>
<td>Remove any blank pages from the original document.</td>
<td>(not selected)</td>
</tr>
<tr>
<td>(6)</td>
<td>Barcode Detection</td>
<td>Detect and recognize barcodes; separates your</td>
<td>(not selected)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>multi-page document whenever a barcode is detected.</td>
<td></td>
</tr>
</tbody>
</table>
Punch Hole Removal

Select the **Punch Hole Removal** check box to remove punch hole markings on scanned images. This feature removes the punch hole markings by filling hole marks with the surrounding color.

![Original](image1.png) ![Punch Hole Removal](image2.png)

**NOTE**

**Punch Hole Removal** is available when the paper size is set to **Automatic**.

Background Setting

Specifying the **Background Setting** allows you to remove or smoothen the base color of scanned documents.

- **Background Processing**
  - Select **None**, **Smooth** or **Removal** from the pop-up list. **Smooth** makes the background smooth, and **Removal** removes the background color.

- **Sensitivity**
  - Move the **Sensitivity** slider to the left or right to adjust the sensitivity to base color or background. The greater the sensitivity value, the better the scan results, the slower the scanning speed.

- **Mode**
  - This option is available only if you select **Smooth** under **Background Processing** above. Select **Automatic** to allow the software to process the image automatically. Select **Moire** to reduce moire.

- **Fill Color**
  - This option is available only if you select **Removal** under **Background Processing** above. Select **White** to make the background white. Select **Automatic** to allow the software to detect the background color automatically and fill it in with the color.
Edge Fill
Select White or Black and set a value (in millimeters) to add a white or black edge around the border of your scanned image.

NOTE
• The maximum edge fill value equals half the length of the shorter side of a selected paper size. For example, if you select a Letter size, which is 8.5 × 11 in., the maximum value for the white edge or black edge is 4.25 in. (or half of 8.5 in.). If you select an A4 size, which is 210 × 297 mm, the maximum value for the white edge or black edge is 105 mm (half of 210 mm).
• If you set a value greater than the maximum allowed, the value automatically defaults to the maximum.
• To disable this feature, set the each value to “0”.

Despeckle
This function allows you to remove small dots or speckles called “noise,” from the background of scanned images. Removing unwanted speckles provides a clear image for OCR processing, and helps to reduce compressed file size.

Define the noise you want to remove by specifying Noise Number (size) and Noise Radius (range).

NOTE
Despeckle is available for black and white images only.
Blank Page Removal Threshold
Select the Blank Page Removal check box to remove blank pages from your scanned image. Move the slider to change the threshold, or level of pixels, that determines a blank page.

Barcode Detection
Select the Barcode Detection check box to split multi-page scanned files whenever a barcode is detected.

Select Barcode Types
Click Select Barcode Type and select the barcode types to specify the barcode you want the scanning software to recognize.

NOTE
• This function is available only when the File Format setting on the File tab is set to PDF or TIFF, and Multi Page Output is selected.
• When you use Barcode Detection to split documents, pages that contain barcodes do not appear in your scan results.
Setting tab

Click the Setting tab to configure additional scanning options.

![Setting tab interface](image)

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Image Count</td>
<td>Specify the number of pages to scan.</td>
<td>Infinite</td>
</tr>
<tr>
<td>(2)</td>
<td>Energy Saver controls</td>
<td>Change settings related to saving energy.</td>
<td>Enable Energy Saver: 15 minutes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Power Off Time: 240 minutes</td>
</tr>
</tbody>
</table>

**Image Count**

This option allows you to specify the number of pages to scan. For example, to scan only the first two pages of a document, move the page slider to “2”.

**NOTE**

- Image Count is not available when using the scanner glass.

**Energy Saver controls**

- **Enable Energy Saver** (Power Saving Mode)
  - Move the slider to set the amount of idle time before the machine enters Power Saving Mode.

- **Power Off Time**
  - Move the slider to set the amount of idle time before the machine automatically powers off.

**NOTE**

- You cannot disable Enable Energy Saver.
- Power Off Time must be greater than or equal to Energy Saver time.
Imprinter tab

Click the **Imprinter** tab to print the date, time, document count, or custom messages on your scanned image.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Digital Imprinter</td>
<td>Select to activate this feature.</td>
<td>(not selected)</td>
</tr>
<tr>
<td>(2)</td>
<td>Print All</td>
<td>Print on every page of the scanned image.</td>
<td>(selected)</td>
</tr>
<tr>
<td>(3)</td>
<td>Custom</td>
<td>Type the custom text to print on your scanned image.</td>
<td>(none)</td>
</tr>
<tr>
<td>(4)</td>
<td>Counter</td>
<td>Change the scan counter.</td>
<td>Number (such as 1234)</td>
</tr>
<tr>
<td>(5)</td>
<td>Date/Time</td>
<td>Change the date/time.</td>
<td>None</td>
</tr>
<tr>
<td>(6)</td>
<td>Custom Font</td>
<td>Select a font.</td>
<td>Normal</td>
</tr>
<tr>
<td>(7)</td>
<td>Font Attributes</td>
<td>Select a font attribute.</td>
<td>Normal</td>
</tr>
<tr>
<td>(8)</td>
<td>String Orientation</td>
<td>Select the print direction.</td>
<td>Normal</td>
</tr>
<tr>
<td>(9)</td>
<td>Print Position</td>
<td>Select a print position.</td>
<td>Middle</td>
</tr>
<tr>
<td>(10)</td>
<td>Sample</td>
<td>Preview your custom text.</td>
<td>(none)</td>
</tr>
<tr>
<td>(11)</td>
<td>More</td>
<td>Set advanced font settings.</td>
<td>Size: 5&lt;br&gt;Density: 0&lt;br&gt;Transparency: 0</td>
</tr>
</tbody>
</table>
**Digital Imprinter**
Select the **Digital Imprinter** check box to use the digital imprinter to print custom text on your scanned image.

**Print All**
Select the **Print All** check box to print the text on every page of the scanned image. Clear the check box to print the text only on the first page of the scanned image.

**Custom**
Type the text you want in your print string (up to 31 characters).

**Counter**
Click ➯ to increase the scan counter.
The number of digits specified here is displayed on the scanned image. For example, selecting Number (123456) causes “000001” to be shown on the first page of the scanned image, “000002” on the second, “000003” on the third, and so forth.

**Date/Time**
Select **Date**, **Time**, or **Date+Time** to include the date or time in your print string.
Click ➯ to select a date or time separator from the pop-up list.

**Custom Font**
Select **Normal** or **Fixed Width** from the **Custom Font** pop-up list.
**Fixed Width** (monospace) fonts use a fixed character spacing, so each character occupies the same width.

**Font Attributes**
Select **Normal**, **Underline**, **Double**, or **Bold** from the **Font Attributes** pop-up list.
**String Orientation**

Select **Normal, Rotated, Vertical, Vertical Inversion, 90 Degrees CW** (clockwise), or **90 Degrees CCW** (counter-clockwise), from the **String Orientation** pop-up list to specify the text’s print direction.

![Text Orientation Examples]

**Print Position**

Select **Top, Middle, Bottom, or Custom** from the **Print Position** pop-up list. If you select **Custom**, enter the **X Offset** and **Y Offset** value to specify the text’s start position.

**Sample**

Preview your text here.
More
Click the **More** button to select additional font properties.

- **Size**
  Move the slider to select font size (Default: 5).

- **Density**
  Move the slider to select font density (Default: 0).

- **Transparency**
  Move the slider to select a transparency value from 0% (not transparent) to 100% (completely transparent). This is useful when creating a partially transparent watermark.
Information tab

Click the Information tab to display system and machine information, such as scanner driver version and firmware version. You can also view the roller count and reset the count in this window.

![Image of Information tab]

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Reset Roller Count</td>
<td>Reset the roller count.</td>
<td>-</td>
</tr>
<tr>
<td>(2)</td>
<td>Language</td>
<td>Change the language of the DS Capture user interface.</td>
<td>(based on OS language)</td>
</tr>
</tbody>
</table>

Reset Roller Count

After replacing the scanner rollers, click the Reset button to reset the roller count.

**NOTE**

Do not reset the counter unless you have replaced the rollers.

Language

Change the language of the DS Capture user interface, if needed.
IMPORTANT
Do not use any solvents or corrosive liquids, such as alcohol or kerosene, to clean any part of your Brother machine, or the plastic may be permanently damaged.

Clean the outside of your machine

To prevent dust accumulation, we recommend cleaning the exterior of your Brother machine periodically. Wipe the outside of the machine with a dry, soft, lint-free cloth.
Clean the Scanner Glass

Press and hold down the power button to turn the machine off.
Lift the document cover.
Clean the scanner glass under the document cover with a soft, lint-free cloth moistened with water.

NOTE
In addition to cleaning the scanner glass and glass strip with a soft, lint-free cloth moistened with water, run your finger tip over the glass to see if you can feel anything on it. If you feel dirt or debris, clean the glass again, concentrating on that area. You may have to repeat the cleaning process three or four times. To test, scan after each cleaning.

Close the document cover.
Clean the inside of your machine

A spot of dirt or correction fluid on the glass strip may cause poor-quality scans. If a vertical line appears in the scanned data or if parts of the document are missing, you must clean the inside of the machine.

1. Unplug the machine from the AC power outlet.
2. Open the Top Cover (1) and the ADF Cover (2).

3. In the ADF unit, clean the glass strips (1) and feed rollers (2) with a soft, lint-free cloth moistened with water.
4 Press and hold the buttons (1) on the inside of the ADF Cover, and then pull the Reverse Roller Cover (2) down.

5 Pinch the Reverse Roller (1) and pull it out of the machine.

6 Clean the Reverse Roller with a soft, lint-free cloth moistened with water.

7 Pinch the Reverse Roller and reinstall it in the machine.
8. Securely close the Reverse Roller Cover (1) until the hooks snap into the ADF Cover.

9. Slide the document guides (1) as far apart as possible and pull the Roller Cover (2) down.

10. Pinch the Pick-up Roller and pull it out of the machine.
11 Pull the blue hook on the Separation Roller down.

12 Pinch the Separation Roller and pull it out of the machine.

13 Clean the Pick-up Roller and the Separation Roller with a soft, lint-free cloth moistened with water.

14 Pinch the Separation Roller and reinstall it in the machine.
15 Lift the blue hook that you pulled down in step 11.

16 Pinch the Pick-up Roller and reinstall it in the machine.

17 Close the Roller Cover (1).

18 Close the ADF Cover and the Top Cover.
NOTE
In addition to cleaning the glass strips with a non-flammable glass cleaner, run your fingertip over the glass to see if you can feel anything on it. If you feel dirt or debris, clean the glass again concentrating on that area. You may need to repeat the cleaning process three or four times. To test, scan a document after each cleaning attempt.

When there is a spot of dirt or correction fluid on the glass strip, the scanned sample shows a vertical line. After the glass strip is cleaned the vertical line is gone.
Replace parts

When your Brother machine detects that scanner parts are nearing their end-of-life period, a warning message appears on your computer monitor.

If the warning message warns you to replace the Pick-up Roller, the Separation Roller, or the Reverse Roller, order new parts, and then replace the used parts with the new ones.

Supply information

The following table lists part names and contains recommendations about usage and replacement:

<table>
<thead>
<tr>
<th>Part Name</th>
<th>Standard Replacement Cycle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick-up Roller</td>
<td></td>
</tr>
<tr>
<td>Separation Roller</td>
<td>200,000 sheets or 5 years</td>
</tr>
<tr>
<td>Reverse Roller</td>
<td></td>
</tr>
</tbody>
</table>

NOTE

• Your replacement cycles may vary depending on the usage environment, types of documents, and scanning frequency.
• We recommend replacing all three rollers at the same time, or the roller count value will be incorrect.
These parts are available at most Brother retailers. If you cannot find the part you need, you can order parts directly from Brother. Visit us online for a complete selection of the Brother parts and supplies.

**In USA:**
- 1-877-552-MALL (1-877-552-6255)
- 1-800-947-1445 (fax)

**In Canada:**
- [www.brothermall.com/](http://www.brothermall.com/)

**Other Countries:**
- [www.brother.com/](http://www.brother.com/)
Check replacement cycle

Your Brother machine is equipped with a scan counter, which automatically counts how many pages the machine scans.

To check the scan count, follow these steps:

For Windows®:
1. Launch DS Capture.
2. Click (Setup), and then click the Information tab.
3. Scroll down in the information window until you see ADF Roller Count, ADF Simplex Count or ADF Duplex Count.

For Macintosh:
1. Launch DS Capture.
2. Click the Information tab.
3. Check ADF Roller Count, ADF Simplex Count or ADF Duplex Count.

Replace the Rollers

When the machine has scanned 200,000 sheets, the machine displays a message “Please replace the roller and reset the roller count.” on your computer to remind you to replace the Rollers.

NOTE
We recommend replacing all three rollers at the same time, or the roller count value will be incorrect.

1. Open the Top Cover (1) and the ADF Cover (2).
2 Press and hold the buttons (1) on the inside of the ADF Cover, and then pull the Reverse Roller Cover (2) down.

3 Pinch the Reverse Roller (1) and pull it out of the machine.

4 Remove the old Reverse Roller from the shaft and insert the new Reverse Roller completely onto the shaft.
5. Pinch the new Reverse Roller and reinstall it in the machine.
6. Securely close the Reverse Roller Cover (1) until the hooks snap into the ADF Cover.

7. Slide the document guides (1) as far as possible and pull the Roller Cover (2) down.

8. Pinch the Pick-up Roller and pull it out of the machine.
9 Pull the blue hook on the Separation Roller down.

10 Pinch the Separation Roller and pull it out of the machine.
11 Pinch a new Separation Roller and reinstall it in the machine.
12 Lift the blue hook that you pulled down in the step 9.

13 Pinch a new Pick-up Roller and reinstall it in the machine.

14 Close the Roller Cover (1).

15 Close the ADF Cover and the Top Cover.

16 Reset the counter (see **Reset the usage counters** on page 111).
Reset the usage counters

After you have replaced scanner parts, reset the usage counter.

For Windows®:
1. Launch DS Capture.
2. Click (Setup), and then click the Information tab.
3. Scroll down in the information window until you see Reset Roller button.
4. Click Reset Roller Count to reset the usage counter.

For Macintosh:
1. Launch DS Capture.
2. Click the Information tab.
3. Click Reset to reset the usage counter.
Packing and shipping the machine

When you transport the machine, use the packing materials that came with your machine. If you do not pack the machine correctly, any damage that may occur in transit may not be covered by your warranty. The machine should be adequately insured with the carrier.

1. Close the Top Cover gently.

2. Carefully turn the machine over. Slide the transport lock switch on the reverse side to the **Locked** position, as shown in the illustration.
3. Wrap the machine in the bag it originally came in.
4 Pack the machine and the printed materials in the original carton with the original packing material as shown below.

NOTE
USA and Canada only. If you are returning your machine to Brother as part of the Exchange Service, pack only the machine. Keep all separate parts (power cord and USB cable) and printed materials to use with your “Exchange” machine.

5 Close the carton and tape it shut.
If you think there is a problem with your Brother machine, check the chart below and follow the suggestions. You can correct most problems yourself. If you need additional help, visit the Brother Solutions Center at support.brother.com and click FAQs & Troubleshooting.

Using non-Brother supplies may affect scan quality, hardware performance and product reliability.

## Error and maintenance messages

### Messages displayed on your machine’s LCD

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADF Cover open</td>
<td>ADF Cover is open.</td>
<td>Close the ADF Cover.</td>
</tr>
<tr>
<td>Document misfeed</td>
<td>Multiple sheets were fed at the same time.</td>
<td>Align the edges of the pages and place your document correctly, and then try again.</td>
</tr>
<tr>
<td>Document Jam/too Long</td>
<td>- The Document Guides are not set to the correct document size.</td>
<td>Clear the document jam (see Document jam on page 118), and then do the following:</td>
</tr>
<tr>
<td></td>
<td>- The settings are not suitable for your document.</td>
<td>- Adjust the Document Guides to fit the width of the document. When Scan Size is set to Auto and you are scanning a document that contains multiple page sizes, insert narrow pages straight and as close to the center of the machine as possible. If the document is cannot be fed straight, use Continuous Scanning.</td>
</tr>
<tr>
<td></td>
<td>- Paper dust has accumulated on the surface of the Pick-up Roller or Feed Roller.</td>
<td>- Confirm the settings. See the IMPORTANT section on page 119.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Clean the rollers. See Clean the inside of your machine on page 98.</td>
</tr>
<tr>
<td>Error message</td>
<td>Cause</td>
<td>Action</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Multifeed error</td>
<td>Multiple pages were fed at the same time.</td>
<td>Remove the pages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Multi-feed on page 120.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reload your documents in the ADF.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Load documents on page 10</td>
</tr>
<tr>
<td></td>
<td>Using a Carrier Sheet.</td>
<td>Enable Carrier Sheet Mode, and then try again. See Carrier Sheet Mode on page 43.</td>
</tr>
<tr>
<td></td>
<td>Your document is not acceptable for the machine.</td>
<td>Make sure your document is suitable for the machine (see Document Information on page 5).</td>
</tr>
<tr>
<td>DRAM R/W test error</td>
<td>A hardware error has occurred.</td>
<td>Contact Brother customer service.</td>
</tr>
<tr>
<td>AFE R/W test error</td>
<td></td>
<td>For more information, see For customer service on page 133.</td>
</tr>
<tr>
<td>NVRAM R/W test error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADF front lamp error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ultrasonic error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADF AFE R/W test error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB R/W test error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FlashROM R/W test error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AFE LVDS test error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADF AFE LVDS test error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ADF rear lamp error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flatbed home position error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flatbed lamp error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lock error</td>
<td>The transport lock is locked.</td>
<td>Unlock the transport lock and turn off and on the scanner.</td>
</tr>
</tbody>
</table>
## Messages displayed on your computer

<table>
<thead>
<tr>
<th>Error message</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A document is jammed in the ADF.</td>
<td>A jammed document stops the scanning process.</td>
<td>Open the top cover and remove the document by pulling it backwards, and then close the top cover.</td>
</tr>
<tr>
<td>Do not open the ADF Cover when scanning.</td>
<td>Your machine’s top cover is open when scanning starts.</td>
<td>Close the top cover and start scanning again.</td>
</tr>
<tr>
<td>No document in ADF.</td>
<td>No document is placed in the ADF.</td>
<td>Place your document in the ADF and start scanning again.</td>
</tr>
<tr>
<td>Cannot find the scanner.</td>
<td>Your machine is not connected to your computer.</td>
<td>Confirm that the USB cable connecting the machine to the computer is connected correctly. The machine may power off automatically if its automatic power off function is on. Press the Power button to turn the machine ON.</td>
</tr>
<tr>
<td>Document misfeeds.</td>
<td>The document is not feeding correctly.</td>
<td>Remove the document, align the pages, place it carefully in the ADF, and then start scanning again.</td>
</tr>
<tr>
<td>Multifeed is detected.</td>
<td>Documents are multifeeded.</td>
<td>Remove the remaining document from the ADF, place it carefully in the ADF, and then start scanning again.</td>
</tr>
<tr>
<td>Unknown error.</td>
<td>-</td>
<td>Contact Brother customer service or your local Brother dealer. See For customer service on page 133.</td>
</tr>
</tbody>
</table>
Document jam

Pages can jam in the ADF if they are not inserted or fed correctly, or if they are too long. Follow the steps below to clear a document jam.

1. Remove any paper that is not jammed from the ADF.
2. Open the ADF Cover pulling the Cover Release Lever (1) towards you.

3. Pull the jammed document out of the machine.

**NOTE**
Check for ripped paper inside the machine. Remove any ripped paper you find.

4. Close the ADF Cover.
5. Confirm that the pages scanned before the jam occurred are saved in the designated folder, and then start scanning again at the next page (or at the beginning of the document, if necessary).
**IMPORTANT**

- To avoid damage to the jammed document, DO NOT pull the document out before opening the ADF Cover.
- Remove any paper from the ADF before closing the ADF Cover.
- To avoid future document jams, do the following:
  - Close the ADF Cover completely by pushing it gently in the middle.
  - Configure the settings for your document correctly.
  - Clean the Rollers. See *Clean the inside of your machine* on page 98
  - Stagger the pages, and then load your document.
  - Make sure your document is acceptable for the machine. See *Acceptable documents* on page 5.
  - Load the card vertically when scanning cards.
- Select **Long Page** from the **Scan Area / Page Size** or **Page Size** drop-down list, under the **Paper** tab when scanning a long document.
**Multi-feed**

A multifeed error means that multiple pages were fed at the same time. To clear the multifeed:

1. Remove any paper from the ADF.
2. Open the ADF Cover pulling the Cover Release Lever (1) towards you.
3. Pull the multifed pages out of the machine.
4. Close the ADF Cover.
5. Confirm that the pages scanned before the multifeed error occurred are saved in the designated folder, and then start scanning again at the next page (or at the beginning of the document, if necessary).
**IMPORTANT**

- Remove any paper from the ADF before closing the ADF Cover.
- To avoid future multi-feeds, do the following:
  - Disable the multifeed detection when scanning business cards.
  - Select the **Carrier Sheet Mode** check box in the **Paper** tab when scanning using the Carrier Sheet.
## Troubleshooting

### Scanning difficulties

<table>
<thead>
<tr>
<th>Difficulty</th>
<th>Cause</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>TWAIN or WIA errors appear when starting to scan. (Windows®)</td>
<td>The TWAIN or WIA driver has not been selected as the primary source in your scanning application.</td>
<td>Make sure the Brother TWAIN or WIA driver is selected as the primary source in your scanning application. For example, in OmniPage SE 18, click Scan Settings, and then click Select to select the Brother TWAIN/WIA driver.</td>
</tr>
<tr>
<td>TWAIN errors appear when starting to scan. (Macintosh)</td>
<td>TWAIN driver has not been selected as the primary source in your scanning application.</td>
<td>Make sure the Brother TWAIN driver is selected as the primary source. In PageManager 9, click File, Select Source, and then select the Brother TWAIN driver. OS X v10.8.x, 10.9.x, 10.10.x or later users can also scan documents using the ICA Scanner Driver.</td>
</tr>
<tr>
<td>My scanned images have black lines running through them, blank spaces, or are of overall bad quality.</td>
<td>This problem occurs if a foreign object, such as a paper clip or ripped paper, is stuck in the machine.</td>
<td>Check the ADF slot and make sure that the slot is clear. If you find foreign objects, remove them from your machine.</td>
</tr>
<tr>
<td>My scanned image is missing.</td>
<td>The Document Guides are not adjusted to fit the width of the document.</td>
<td>Adjust the Document Guide to fit the width of the document. When Cropping is set to Automatic (Deskew ON) and you are scanning a document that contains multiple page sizes, insert narrow pages straight and as close to the center of the machine as possible. If the document does not stay straight while feeding, use Continuous Scanning.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Make sure the document size settings are suitable for your document. For Windows®: see Paper tab on page 40. For Macintosh: see Paper tab on page 79.</td>
</tr>
<tr>
<td>The scan speed is too slow.</td>
<td>The resolution is not suitable for your document.</td>
<td>Decrease the machine resolution. For Windows®: see Image tab on page 31. For Macintosh: see Image tab on page 69.</td>
</tr>
<tr>
<td>Unusual noise occurs when the power is ON.</td>
<td></td>
<td>Check the transport lock is unlocked.</td>
</tr>
<tr>
<td>Difficulty</td>
<td>Cause</td>
<td>Suggestions</td>
</tr>
<tr>
<td>----------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>My machine is connected but it does not feed my document or do anything else.</td>
<td>Your document is placed incorrectly.</td>
<td>Insert your document until you feel the top edge of the document touch the inside of your machine.</td>
</tr>
<tr>
<td></td>
<td>Your document is too thin or too thick.</td>
<td>Check that your document is acceptable (see Document Information on page 5). If your document is acceptable: 1. Confirm that the USB cable connecting your machine to your computer is connected correctly. 2. Reinstall the scanner driver from the Brother installation DVD.</td>
</tr>
<tr>
<td></td>
<td>Paper dust has accumulated on the surface of the rollers.</td>
<td>Clean the rollers. See Clean the inside of your machine on page 98.</td>
</tr>
<tr>
<td></td>
<td>Too many documents are loaded in the ADF at a time.</td>
<td>Make sure your document is acceptable for the machine. See Document Information on page 5.</td>
</tr>
<tr>
<td></td>
<td>There are foreign objects in the ADF.</td>
<td>Remove any foreign objects or ripped paper from the ADF.</td>
</tr>
<tr>
<td>A multifeed occurs.</td>
<td>Paper dust has accumulated on the surface of the rollers.</td>
<td>Clean the rollers. See Clean the inside of your machine on page 98.</td>
</tr>
<tr>
<td></td>
<td>Too many documents are loaded in the ADF at a time.</td>
<td>Load no more than 100 pages at a time. See Document Information on page 5.</td>
</tr>
<tr>
<td></td>
<td>The document is sticky or has a sticky note on it, which caused a multi-feed.</td>
<td>Use the Carrier Sheet to scan the multifed document.</td>
</tr>
<tr>
<td>The document is jammed.</td>
<td>Causes may vary.</td>
<td>Open the machine’s top cover and gently pull out the document. Make sure no paper remains in the machine.</td>
</tr>
<tr>
<td></td>
<td>Your document is not acceptable for the machine (for example, if the paper is too long).</td>
<td>■ Make sure your document is suitable for the machine (see Document Information on page 5).  ■ Use the Carrier Sheet (see Loading documents using the Carrier Sheet in the ADF on page 16).</td>
</tr>
<tr>
<td></td>
<td>Paper dust has accumulated on the surface of the rollers.</td>
<td>Clean the rollers. See Clean the inside of your machine on page 98.</td>
</tr>
<tr>
<td></td>
<td>There are foreign objects in the ADF.</td>
<td>Remove any foreign objects or ripped paper from the ADF.</td>
</tr>
<tr>
<td>My machine gets warm.</td>
<td>It is normal for your machine to emit a small amount of heat after prolonged use.</td>
<td>If there is a strange smell coming from the machine or the machine feels hot to the touch, immediately remove the power cord and USB cable from your machine. Contact Brother customer service or your local Brother dealer. See For customer service on page 133.</td>
</tr>
<tr>
<td>The scan quality is poor.</td>
<td>Paper dust has accumulated inside your machine.</td>
<td>Clean your machine (see Maintenance on page 96).</td>
</tr>
<tr>
<td></td>
<td>The machine resolution is too low.</td>
<td>Increase the machine resolution.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For Windows®: see Image tab on page 31.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For Macintosh: see Image tab on page 69.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Difficulty</th>
<th>Cause</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colors in the scanned image are dark.</td>
<td>The settings are not appropriate for the type of document being scanned.</td>
<td>Adjust the scan settings. For Windows®: see Image tab on page 31. For Macintosh: see Image tab on page 69.</td>
</tr>
<tr>
<td>A page that is not a blank page was skipped.</td>
<td>The document’s contents are too light, or Blank Page Removal is set to On.</td>
<td>Set Blank Page Removal to Off. For Windows®: see Paper tab on page 40. For Macintosh: see Paper tab on page 79.</td>
</tr>
<tr>
<td>The scanned image is skewed (crooked).</td>
<td>The machine’s Document Guides are not adjusted to fit the width of the document.</td>
<td>Adjust the Document Guides to fit the width of the document. When Cropping is set to Automatic (Deskew ON) and you are scanning a document that contains multiple page sizes, insert narrow pages straight and as close to the center of the machine as possible. If the document does not stay straight while feeding, use Continuous Scanning. Set Cropping to Automatic (Deskew ON). For Windows®: see Enhancement tab on page 52. For Macintosh: see Enhancement tab on page 86.</td>
</tr>
<tr>
<td>White vertical lines or white stripes appear on the scanned image.</td>
<td>The machine is under direct sunlight. A light source is near the machine.</td>
<td>Move the machine out of direct sunlight. Move the machine far away from the light source.</td>
</tr>
<tr>
<td>Bleed-through is seen in the scanned image.</td>
<td>Your document is too thin. The contrast setting is incorrect. The Background Processing feature is set to Off.</td>
<td>Check that your document is acceptable (see Document Information on page 5). Increase the contrast level. For Windows®: see Image tab on page 31. For Macintosh: see Image tab on page 69. Set Background Processing to On (see Background setting on Enhancement tab on page 52).</td>
</tr>
</tbody>
</table>
### Software difficulties

<table>
<thead>
<tr>
<th>Difficulty</th>
<th>Cause</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>When I click <strong>Scan</strong> in my scanning software, an error message appears: <strong>Cannot find the scanner</strong> or <strong>Operation system error.</strong></td>
<td>This error message appears if your machine is not recognized by your computer.</td>
<td>1. Make sure your machine is connected correctly. 2. Confirm that the USB cable is working and that it is not frayed or damaged in any way. If the error still appears after verifying that the USB cable is connected correctly, reinstall the scanner driver from Brother installation DVD.</td>
</tr>
<tr>
<td>I cannot install the scanner drivers. (Windows®)</td>
<td>You may not have been given administrator privileges.</td>
<td>Log into Windows® with administrator rights.</td>
</tr>
<tr>
<td>I cannot install the scanner drivers. (Macintosh)</td>
<td>You may not have been given administrator privileges.</td>
<td>From the Apple menu, select <strong>System Preferences &gt; System &gt; Users &amp; Groups.</strong> The left pane of the window lists the current accounts, one of which should be your name with the word “Admin” below. If this is not the case, contact your system administrator.</td>
</tr>
<tr>
<td>The file size is too large.</td>
<td>The physical size of the document and the amount of text / graphics on each page affect the resulting file size and cannot be changed.</td>
<td>To produce the smallest scan file for a given document, use the lowest resolution and Black and White mode, and scan the smallest area possible. Using the opposite settings (scanned in the highest resolution, in the Color mode, and scanning the largest area possible) produces the largest-sized file. For Windows®, see <strong>Change scan settings using the TWAIN driver</strong> on page 27. For Macintosh: see <strong>Change scan settings using the TWAIN driver</strong> on page 66.</td>
</tr>
</tbody>
</table>

### Other difficulties

<table>
<thead>
<tr>
<th>Difficulty</th>
<th>Cause</th>
<th>Suggestions</th>
</tr>
</thead>
<tbody>
<tr>
<td>I want to use a USB hub.</td>
<td>-</td>
<td>Use your machine without connecting to a USB hub.</td>
</tr>
</tbody>
</table>
Appendix A

Specifications

General

<table>
<thead>
<tr>
<th></th>
<th>PDS-5000F</th>
<th>PDS-6000F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Capacity Standard</td>
<td></td>
<td>512 MB</td>
</tr>
<tr>
<td>Power Source</td>
<td></td>
<td>100 - 240 V AC 50/60 Hz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>24 V DC 2 A</td>
</tr>
<tr>
<td>LCD (Liquid Crystal Display)</td>
<td></td>
<td>16 characters × 2 lines</td>
</tr>
<tr>
<td>Power Consumption¹</td>
<td>Scanning</td>
<td>53 W</td>
</tr>
<tr>
<td></td>
<td>Ready</td>
<td>17.6 W</td>
</tr>
<tr>
<td></td>
<td>Power Saving</td>
<td>2.7 W</td>
</tr>
<tr>
<td></td>
<td>Power OFF</td>
<td>0.3 W</td>
</tr>
</tbody>
</table>
### Dimensions

<table>
<thead>
<tr>
<th></th>
<th>PDS-5000F</th>
<th>PDS-6000F</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Weight</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Approx. 20.3 lbs (9.20 kg)</td>
<td></td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>41 to 95 °F (5 to 35 °C)</td>
<td></td>
</tr>
<tr>
<td><strong>Humidity</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>20 to 80%</td>
<td></td>
</tr>
<tr>
<td>Storage</td>
<td>10 to 90%</td>
<td></td>
</tr>
<tr>
<td><strong>ADF (Automatic Document Feeder)</strong></td>
<td>Up to 100 pages (Paper: 20 lb (80 g/m²))</td>
<td></td>
</tr>
</tbody>
</table>
## Document Size

<table>
<thead>
<tr>
<th>Document Size</th>
<th>Multiple Paper</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Width</td>
<td>2.0 in. to 8.58 in. (51 mm to 218 mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Length</td>
<td>2.13 in. to 14.0 in. (54 mm to 356 mm)</td>
<td></td>
</tr>
<tr>
<td>Single Paper</td>
<td>Width</td>
<td>2.0 in. to 8.58 in. (51 mm to 218 mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Length</td>
<td>2.13 in. to 236.0 in. (54 mm to 5,994 mm)</td>
<td>1-sided scan</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2.13 in. to 14.0 in. (54 mm to 356 mm)</td>
<td>2-sided scan</td>
</tr>
<tr>
<td>Flatbed</td>
<td>Width</td>
<td>Maximum: 8.5 in. (216 mm)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Length</td>
<td>Maximum: 14.0 in. (356 mm)</td>
<td></td>
</tr>
</tbody>
</table>

1. Measured when the machine is connected to your computer.
2. For a 200 dpi scan.
# Scanner

<table>
<thead>
<tr>
<th></th>
<th>PDS-5000F</th>
<th>PDS-6000F</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Color / Black</strong></td>
<td>Yes / Yes</td>
<td></td>
</tr>
<tr>
<td><strong>Duplex Scan</strong></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td><strong>TWAIN Compliant</strong></td>
<td>Windows®</td>
<td>Windows Vista® / Windows® 7, 8, 8.1, 10</td>
</tr>
<tr>
<td></td>
<td>Macintosh</td>
<td>OS X v10.8.x, 10.9.x, 10.10.x or later¹</td>
</tr>
<tr>
<td><strong>WIA Compliant</strong></td>
<td>Windows®</td>
<td>Windows Vista® / Windows® 7, 8, 8.1, 10</td>
</tr>
<tr>
<td><strong>ICA Compliant</strong></td>
<td>Macintosh</td>
<td>OS X v10.8.x, 10.9.x, 10.10.x or later¹</td>
</tr>
<tr>
<td><strong>ISIS™ Compliant</strong></td>
<td>Windows®</td>
<td>Windows Vista® / Windows® 7, 8, 8.1, 10</td>
</tr>
<tr>
<td><strong>Color Depth</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Input</strong></td>
<td>48 bit color processing</td>
<td></td>
</tr>
<tr>
<td><strong>Output</strong></td>
<td>24 bit color processing</td>
<td></td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Optical</strong></td>
<td>Up to 600 x 600 dpi</td>
<td></td>
</tr>
<tr>
<td><strong>Interpolated</strong></td>
<td>Up to 600 x 600 dpi</td>
<td></td>
</tr>
<tr>
<td><strong>Scanning Width</strong></td>
<td></td>
<td>Up to 216 mm</td>
</tr>
<tr>
<td><strong>Gray Scale</strong></td>
<td></td>
<td>8 bit</td>
</tr>
<tr>
<td><strong>Scanning Max. Speed</strong>²</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mono</strong></td>
<td>60 ppm (200 / 300 dpi)</td>
<td>80 ppm (200 / 300 dpi)</td>
</tr>
<tr>
<td></td>
<td>15 ppm (600 dpi)</td>
<td>20 ppm (600 dpi)</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>60 ppm (200 / 300 dpi)</td>
<td>80 ppm (200 / 300 dpi)</td>
</tr>
<tr>
<td></td>
<td>15 ppm (600 dpi)</td>
<td>20 ppm (600 dpi)</td>
</tr>
<tr>
<td><strong>Duplex Scanning Max. Speed</strong>²</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mono</strong></td>
<td>60 ppm / 120 ipm (200 / 300 dpi)</td>
<td>80 ppm / 160 ipm (200 / 300 dpi)</td>
</tr>
<tr>
<td></td>
<td>15 ppm / 30 ipm (600 dpi)</td>
<td>20 ppm / 40 ipm (600 dpi)</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>60 ppm / 120 ipm (200 / 300 dpi)</td>
<td>80 ppm / 160 ipm (200 / 300 dpi)</td>
</tr>
<tr>
<td></td>
<td>15 ppm / 30 ipm (600 dpi)</td>
<td>20 ppm / 40 ipm (600 dpi)</td>
</tr>
<tr>
<td><strong>Flatbed Scanning Speed</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1.8 s (200/300 dpi, Color/Gray, A4)</td>
<td>1.8 s (200/300 dpi, Color/Gray, A4)</td>
</tr>
<tr>
<td></td>
<td>7.6 s (600 dpi, Color/Gray, A4)</td>
<td>7.6 s (600 dpi, Color/Gray, A4)</td>
</tr>
</tbody>
</table>

¹ For the latest driver updates for the Mac OS X version you are using, visit us at support.brother.com

² The actual speed may be slower, depending on your computer specifications and scan settings.
Interfaces

| USB       | SuperSpeed USB 3.0  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Use a USB 3.0 cable (Type B) that is no more than 1.8 meters long.</td>
</tr>
</tbody>
</table>

1 Your Brother machine has a Hi-Speed USB 3.0/USB 2.0/USB 1.1/USB 1.0 interface. The machine can also be connected to a computer that has a USB 2.0/USB 1.1/USB 1.0 interface.

2 Third party USB ports are not supported.

Supported languages

| Display Languages       | English, French, German, Italian, Spanish, Portuguese, Dutch, Norwegian, Swedish, Danish, Russian, Czech, Hungarian, Polish, Bulgarian, Romanian, Slovakian, Finnish |

The default setting displayed on your Brother machine’s LCD is based on the connected computer’s OS language. If the OS language is not one of the supported languages as listed in the table above, the LCD displays English.
## Computer requirements

### Supported Operating Systems and Software Functions

<table>
<thead>
<tr>
<th>Computer Platform and Operating System Version</th>
<th>Minimum Processor Speed</th>
<th>Minimum RAM</th>
<th>Recommended RAM</th>
<th>Hard Disk Space to Install</th>
<th>Supported Computer Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows® Operating System</td>
<td>Intel® Core™ 2 Duo or equivalent 64-bit (Intel® 64 or AMD64) supported CPU</td>
<td>1 GB</td>
<td>2 GB</td>
<td>50 MB</td>
<td>1.5 GB</td>
</tr>
<tr>
<td>Windows Vista®</td>
<td>Intel® Core™ 2 Duo or equivalent 64-bit (Intel® 64 or AMD64) supported CPU</td>
<td>1 GB (32-bit)</td>
<td>2 GB (32-bit)</td>
<td>50 MB</td>
<td>1.5 GB</td>
</tr>
<tr>
<td>Windows® 7</td>
<td>Intel® Core™ 2 Duo or equivalent 64-bit (Intel® 64 or AMD64) supported CPU</td>
<td>2 GB (64-bit)</td>
<td>4 GB (64-bit)</td>
<td>50 MB</td>
<td>1.5 GB</td>
</tr>
<tr>
<td>Windows® 8/8.1/10</td>
<td>Intel® Core™ i3 or equivalent 64-bit (Intel® 64 or AMD64) supported CPU</td>
<td>1 GB (32-bit)</td>
<td>2 GB (32-bit)</td>
<td>50 MB</td>
<td>1.5 GB</td>
</tr>
<tr>
<td>Macintosh Operating System</td>
<td>Intel® Processor</td>
<td>2 GB</td>
<td>4 GB</td>
<td>50 MB</td>
<td>400 MB</td>
</tr>
<tr>
<td>OS X 10.8.x</td>
<td>Intel® Processor</td>
<td>2 GB</td>
<td>4 GB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS X 10.9.x</td>
<td>Intel® Processor</td>
<td>2 GB</td>
<td>4 GB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OS X 10.10.x</td>
<td>Intel® Processor</td>
<td>2 GB</td>
<td>4 GB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For the latest driver updates, visit support.brother.com

All trademarks, brand and product names are property of their respective companies.
Contact Brother

Register your product online at

www.brother.com/registration

By registering your product with Brother, you will be recorded as the original owner of the product. Your registration with Brother:

• may serve as confirmation of the purchase date of your product should you lose your receipt;
• may support an insurance claim by you in the event of product loss covered by insurance; and,
• will help us notify you of enhancements to your product and special offers.

The most convenient and efficient way to register your new product is online at: www.brother.com/registration

Frequently Asked Questions (FAQs)

The Brother Solutions Center is our one-stop resource for all your Brother machine needs. You can download the latest software documents and utilities, read FAQs and troubleshooting tips, and learn how to get the most from your Brother product.

support.brother.com

• Check here for Brother driver updates.
• To keep your machine’s performance up to date, check here for the latest firmware upgrade.
For customer service

Visit support.brother.com for technical support and contact information of your local Brother office.

In USA: www.brother-usa.com
1-877-BROTHER (1-877-276-8437)
1-901-379-1215 (fax)
In Canada: www.brother.ca/support
(Self-SERVICE, Videos, Email, Chat, Facebook and Twitter Help)

Service Center Locator (USA only)
For the location of a Brother authorized service center, call 1-877-BROTHER
(1-877-276-8437) or visit www.brother-usa.com/service

Service Center Locations (Canada only)
For the location of a Brother authorized service center, visit www.brother.ca/support

If you have comments or suggestions, please write us at:
In USA: Printer Customer Support
Brother International Corporation
7905 North Brother Boulevard
Bartlett, TN 38133
In Canada: Brother International Corporation (Canada), Ltd.
- Marketing Dept.
1, Rue Hotel de Ville Dollard-des-Ormeaux, PQ, Canada H9B 3H6

Other Countries: Visit www.brother.com/ for contact information for your local Brother office.

For Brother accessories & supplies

In USA: www.brothermall.com/
1-877-552-MALL (1-877-552-6255)
1-800-947-1445 (assistance via fax)
In Canada: www.brother.ca/
In UK: www.brother.co.uk/
Other Countries: Visit www.brother.com/ for contact information for your local Brother office.
Technical support (for PageManager)

For USA
Company name: NewSoft America Inc.
Postal Address: 47102 Mission Falls Court, Suite 202 Fremont CA 94539
Telephone: 510-770-8900
Fax: 510-770-8980
E-mail Address: contactus@newsoftinc.com
URL: www.newsoftinc.com

For Canada
E-mail Address: contactus@newsoftinc.com

Other countries
E-mail Address: tech@newsoft.eu.com

NOTE
For all other issues, see For customer service on page 133.